
 
 

 
 

 

 



 
 

Аннотация 

Магистирлик диссертацияси темир йўл автоматикаси микропроцессор 

қурилмаларини ўрганиш бўйича лаборатория мажмуасини ишлаб чиқиш 

назарий ва амалий аҳамияти масалаларига асосланади. Диссертация ишида 

MICROCHIP компаниясининг PIC оиласи микроконтроллерлари билан 

ишлаш, уларга дастур ёзиш, периферия қурилмалари билан ишлаш 

масалалари баён этилган. MPLAB дастурий мухити билан ишлаш ва 

микроконтроллерларга дастурларни юклаш услублари кўриб ўтилган. 

Қўл ёзма ____ варақ, ____ расм , _____ жадвал ва ____фойдаланилган 

адабиётлар ва иловадан иборат. 

 

 

 

 

 

 

Annotation 

Master’s thesis is based on producing practical and theoretical matters of 

creating laboratory complexes on researching railway mechanism 

microprocessor devices. In dissertation working with microcontrollers of 

Microchip company’s PIC family, installing programmes to them, matters of 

working with peripheral devices are explained. Working in the atmosphere of 

MPLAB programme and ways of downloading programmes to microcontrollers 

are shown. 

Dissertation work consists of ____ pages, ____ photos, ____ table and 

_____ literature list with the name. 
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Кириш 

Магистрлик диссертацияси мавзусининг асосланиши ва унинг 

долзарблиги. Давлатимиз раҳбари  2015-йилги давлатнинг ижтимоий-

иқтисодий ривожланиши  натижалари ва 2016-йилдаги муҳим устувор 

йўналишлари  бўйича ўзининг бошқарув мажлисидаги маърузасида 

белгилаганидек, бизнинг темир йўлчиларимиз олдида бу йил катта 

вазифалар турибди. 2016-йилда Ўзбекистон ҳудуди бўйлаб ички ва 

халқаро юклар транзитини ишончли таъминлайдиган такомиллашган 

транспорт тизими ва логистикаси ишини изчил  давом эттириш керак. 

Бугун республикада транспорт потенциалининг келажакдаги тараққиёти 

бўйича, мамлакатнинг сиёсий ва иқтисодий мустақиллиги 

мустаҳкамланишига имкон берадиган, унинг дунё ҳамжамиятидаги фаол 

интеграциясини таъминлайдиган, мақсадга йўналтирилган чора тадбирлар 

олиб борилмоқда. Хусусан, мамлакат ичида янги темир йўл линиялари 

қурилиши, амалга оширилади, темир йўл участкалари асосий транзитида 

электрификация ва қайта таъмирлаш ишларини олиб бориш, йўловчилар 

талабига биноан ташишнинг қисқа ва қулай йўлларини ва янги 

маршрутлар ташкил қилиш, ҳаракатдаги таркибнинг янгиланиши ва 

модернизацияси амалга оширилади. 

Темир йўлларбугун нафақат биз ва бизнинг юкларни мўлжалланган 

пунктга олиб боради, балки шаҳарлар ва халқларнинг тақдирини 

бирлаштиради. Темир йўл транспорти қўшни давлатлар билан иқтисодий 

алоқаларни амалга оширишда қанчалик аҳамиятли рол ўйнамасин, худди 

МДҲ давлатлари қатнашчилари билан бўлгани каби компания темир йўл 

транспорти ҳудудларида икки томонлама розиликка эга бўлади, шунингдек 

узоқ чет давлатлар билан ҳам. Бундан ташқари  «Ўзбекистон темир 

йўллари» БМТ нинг  Ўрта Осиё ва Осиё тинч океани ҳудуди (UNESCAP) 

учуниқтисодий ва ижтимоий кенгаши, Темир йўллар ҳамкорлик 

ташкилоти  (ОСЖД, Bapшaвa), МДҲ ва Балтия мамлакатлари, Финляндия, 



 
 

Болгария иштирокидаги темир йўл транспорти ташкилоти аъзоси 

ҳисобланади.  

Микроэлектроника ривожининг замонавий босқичида темир йўл 

транспорти бошқарув вазифаларида микропроцессор ва 

микроконтроллерлар,  автоматлаштириш ва сигналларни қайта ишлашни 

қўллашга қизиқиш ўсиб бормоқда. Микропроцессорларда худди мураккаб 

микроэлектрон қурилмалардаги каби муҳандислик ва илмий ғояларнинг 

энг илғор ютуқлари мужассамланган. Шунинг учун микропроцессорли 

техника (МПТ)  каби гуркираб ривожланаётган, доимий 

такомиллаштиришни талаб қилаётган илмий ҳудудни ўрганиш, фойдали 

илмий техникавий ҳудудлар билан танишув ва томчилаб йиғилган 

билимлар билан тўлдирилиши муҳим вазифадир. Микропроцессорлардан 

фойдаланиш билан профессионал боғланган замонавий мутахассис 

масаласини амалий жиҳатдан фойдали ҳал этиш учун қурилма асоси 

микропроцессорли қурилмаларнинг элементларини функциялаштирилиши 

ҳақида нафақат тассаввурга эга бўлиши, балки батафсил тизимлар яратиш 

жараёнига маданий ёндашишиҳам керак. Шундай қилиб тузатилган 

аппарат дастури комплекси (ТАДК) ни ишлаб чиқиш, тажриба стенди 

сифатида фойдаланиш, талабаларни муҳандислик вазифаларини ҳал 

этишда ижодий имкониятларини ривожлантиришга имкон беради. КИС ва 

ЖКИС ларга қуйидагиларни оид деб топиш мумкин: микропроцессор 

мажмуалари ва микроконтроллерлар, дастурланадиган логик матрицалар 

ва баъзавий  матрицали кристаллар, аналог рақамли ва рақам аналогли 

ўзгартиргичлар, шунингдек эслаб қоладиган қурилмалар.Булар 

структурали қурилишда қийин ва интегралли компонентлар функционал 

тушунчасида кўрсатилган тизимларда кенг қўлланилади ва уларнинг 

тузилишида асосий бўлиб келади. 

Бироқ рақамли электроникани ўрганиш, айниқса у асосида тизим 

лойиҳалаштирилишини ўзлаштириш, интеграл қурилмаларни 

микросхемотехника ва системотехникалар билан бошлаш 



 
 

қийинэканлигини кўрсатади. Шунинг учун биринчи навбатда, рақамли 

электрониканинг у қадар мураккаб бўлмаган функционал узеллари иши 

алгоритмларини ва ички қурилмаларини ўрганиш талаб этилади.  

Малакали мутахассисларни замонавий лаборатория базасисиз 

тайёрлаш имкони бўлмай, бундай базада талабалар нафақат олган назарий 

билимларини мустаҳкамлаш, балки амалий тадқиқот кўникмаларига ёки 

ишлаб чиқариш тажрибаларига, хомашё саноати компонентлари ва 

уларнинг вазифалари тизими синов муддати ва лойиҳалаштириш 

малакасига эга бўлишлари мумкин. 

Бироқ, деярли барча фанлар бўйича ўқув лабораторияларини яратиш 

замонавий ускуналарни харид қилиш, амалий тажрибалар ўтказишда 

юқори малакали шахсларни тайёрлаш режасини ишлаб чиқиш ва уларга 

хизмат кўрсатиш ва меҳнатига ҳақ тўлаш учун каттагина молиявий маблағ 

талаб этади. Давлат таълим муассасаларининг мавжуд молиявий 

таъминотида институт лаборатория базасини анъанавий усуллар ёрдамида 

янгилаш иши ўнлаб йилларга чўзилиб кетиши мумкин. Шу билан бирга 

фан ва техника, турли тармоқларнинг ривожланиш суръатлари ушбу 

тармоқдаги янгиликларни ўқув жараёнида узлуксиз ва жадал кузатиб 

бориш масаласини кўтариб чиқмоқда. 

Етарлича катта бўлмаган муддатларда қабул қилинган молиявий 

маблағлар асосида  кўрилаётган муаммоларни ҳал этиш учун замонавий 

лаборатория базаларини яратишнинг ҳақиқий имконияти мавжуд. 

Тадқиқот объектлари ва предмети. Тадқиқот объекти Miсrochip 

Technology Incorporated компаниясининг 8 разрядли PIC16F873A 

микроконтроллерларини ўрганишга бағишланган ишлаб чиқилаётган 

лаборатория ишлари мажмуи ҳисобланади. Тадқиқот предмети 

лаборатория ишини бажариш учун мўжалланган микроконтроллерларни 

ўрганиш бўйича универсал лаборатория стенди ҳисобланади. 

Тадқиқот мақсади ва вазифалари. Ишнинг мақсади 

микропроцессорли қурилмаларни ўрганиш ва уларни методик 



 
 

таъминланишини ишлаб чиқиш бўйича тажриба ишлари мажмуасини 

яратиш ҳисобланади. 

Бу мақсадга эришиш учун қуйидаги вазифалар бажарилиши керак: 

Фан бўйича лаборатария ишлари ҳолати  ва тараққиётини кўриб 

чиқиш;   

Микроконтроллерларни ўрганиш бўйича мавжуд лаборатория 

макетлари ва стендларини кўриб чиқиш; 

МicroChip PIC микроконтроллери ишини ўрганиш бўйича лаборатория 

ускуналарининг функционал схемасини кўриб чиқиш; 

MPLAB муҳитида лаборатория ишини ишлаб чиқиш; 

Илмий янгилиги. Ишнинг янги натижалари янгидан ишлаб 

чиқилаётган лаборатория ишлари ва улар бўйича темир йўл автоматикаси 

микроэлектрон техниканиси ўрганишга бағишланган услубий 

кўрсатмаларни ишлаб чиқиш ҳисобланади; 

Тадқиқот асосий масалари ва фаразлари. Тадқиқотнинг асосий 

масалалари замонавий илғор петогогик ўқитиш технологияларидан 

фойдаланган холда, микроконтроллерларни ўрганиш бўйича лаборатория 

методик мажмуасини ишлаб чиқишдан иборат. Ишлаб чиқилган 

лаборатория мажмуаси асосида талабаларга билим бериш сифатини 

ошириш ва олинган билимларни мустақил тарзда чуқурлаштириш ва 

мустаҳкамлашга ҳизмат қилади. 

Мавзу бўйича қисқача адабиётлар шарҳи (тахлили). “Таълим 

тўғрисидаги”ги Қонун, “Кадрлар тайёрлаш Миллий дастури”, Президент 

И.А. Каримовнинг асарлари ва нутқларидаги олий таълимни янада 

ривожлантириш бўйича кўрсатмалари, замонавий иннавацион педагогика 

асослари, илғор педагогик ва замонавий ахборот технологиялари, 

мультимедия дастурий таъминоти, фанларнинг ўқув-услубий мажмуалари, 

ўқув модулларини яратиш масалаларига бағишланган меъёрий, илмий, 

ўқув адабиётлари ҳамда илмий-техник ва илмий-услубий даврий нашрлар, 

шунингдек Интернет материалларидан фойдаланилди. 



 
 

Тадқиқотда қўлланилган методиканинг тавфсифи. Замонавий 

педагогиканинг услуб ва усуллари, илғор педогогик ва замонавий ахборот 

технологиялари, электрон ўқув ресуслари, компьютер ва компьютер 

тармоқлари учун мультимедия дастурий таъминот бўйича мавжуд 

ишланмалари тадқиқотда қўлланилган. 

Тадқиқот натижаларининг назарий ва амалий ахамияти. 

Замонавий илғор педогогик техналогияларни қўлланган ҳолда, назарий 

маълумотларни мустаҳкамлашга имкон берувчи лаборатория ишларини 

йўлга қўйиш, микроэлектрон техника иши бўйича талабалар билан 

кўникма ва маҳоратга эга бўлиш; 

Диссертация тадқиқоти натижалари - "Темир йўл автоматикаси ва 

телемеханикаси микропроцессор қурилмалари ва бошқарув тизимлари" 

фанидан лаборатория ишини бажариш бўйича замонавий лаборатория 

мажмуасидир. 

Иш тузилмасининг тавсифи. Магистрлик диссертацияси кириш, учта 

боб, хулосалар, фойдаланилган ва ўрганилган адабиётлар рўйзати хамда 

иловалардан ташкил топган. 

Биринчи бобда микроконтроллерларни ўрганиш бўйича лаборатория 

ишларини  ривожланиш истиқболлари ва ҳолати кўриб чиқилади; Иккинчи 

бобда виртуал лаборатория ишларини ишлаб чиқиш амалга оширилади; 

Учинчи бобда универсал микропроцессорли модул асосида Microchip PIC 

микроконтроллерларини ўрганиш бўйича лаборатория ишлари 

жамланмасини ишлаб чиқиш ишлари олиб борилади. Ишда баён этилган 

асосий натижалар муаллиф томонидан мустақил бажарилган.  

Иш апробацияси ва нашр этилганлиги. Диссертация ишининг алоҳида 

қисмлари ТошТЙМИ нинг илмий техник конференцияларида, шунингдек 

“Темир йўл транспорти автоматика ва телемеханика” кафедраси 

йиғилишларида вақти-вақти билан маъруза қилинди. Диссертация иши 

бўйича учта иш босиб чиқарилган ва фойдаланишга топширилган. 



 
 

I боб.Фан бўйича лаборатория ишлари ривожининг ҳолати ва 

истиқболлари  

 

1.1. Микропроцессор техникасини ўрганиш бўйича мавжуд 

макетлар жорий ҳолатининг таҳлили 

 

Бугунги кунда ўқув жараёнида  микропроцессор техникаси билан 

боғлиқ фанлар бўйича лаборатория машғулотларини ўтказиш учун техник 

ускуналар фондини янгилаш муаммоси мавжуд: стендлар ва асбоблар 

маънавий эскириб,тўзимоқда,замонавий ускуналарни харид қилиш эса кўп 

маблағ ва меҳнат талаб қилади.  

Тошкент темир йўл муҳандислари институтининг «Темир йўл 

транспортида автоматика ва телемеханика» кафедрасида 

микропроцессорқурилмаларини ўрганиш учун мўлжалланган бир қатор 

стендлар ва макетлар мавжуд. Аммо улардан кўпчилиги ҳозирга келиб 

маънавий эскирган ва баъзилари ишламайди. 

Кафедрада 580 серия микропроцессорларини ўрганишга қаратилган 

лаборатория тренажерлари бўлиб, бироқ уларнинг бари ишламайдиган 

аҳволда;  

Қуйидагилар йўқ: Microchip PIC18, PIC24 ва PIC32 замонавий 

микроконтроллерлар оиласини ўрганиш бўйича лаборатория 

тренажерлари;  ОХҚ (ОЗУ) ва ДХҚ (ПЗУ) ларни ўрганиш бўйича 

лабораториямакетлари; Microchip PIC16F873A микроконтроллерларини 

ўрганиш бўйича  лабораториястендлари. 

Кафедранинг ўз кучи билан лабораторияускуналарини ишлаб чиқиш 

муаммони ҳал қилиши мумкин. Бу йўналишлар осон эмас, албатта, аммо 

олинган ускуналар институт таълим дастурларининг барча талабларига 

мувофиқ бўлар эди. 

  



 
 

1.2. Микропроцессор қурилмаларини ўрганиш бўйича лаборатория 

практикумига бўлган объектив зарурият 

 

Лаборатория практикуми – табиий-илмий, умумий касб-ҳунар ва 

махсус тайёргарликнинг потенциал жиҳатдан энг аҳамиятли ва самарали 

компоненти бўлиб, у реал ускуналарда ишлаш кўникмаларига эга бўлишга 

қаратилган техника ва технологиялардан иборат бўлиб, бўлғуси 

мутахассис ўз амалий фаолиятида бу каби ускуна аналогларида ишлашига 

тўғри келади [9]. 

Лаборатория практикуми ихтисослаштирилган ўқув лабораторияларида 

ўтказилади. Мазкур машғулот турининг самарадорлиги кўп жиҳатдан 

таълим муассасасининг қуйидаги имкониятлари билан белгиланади: 

ўқув лабораторияларини замонавий ускуналар билан жиҳозлаш; 

лаборатория ишлари тажрибаларида ўрганиш объектларини ва улар 

мазмунини танлаш; 

ишларни бажариш самарали технологияларини амалга ошириш ва ҳ.к. 

Сўнгги пайтда, компьютерда моделлаштирувчи тизимларнинг кенг 

татбиқ этилишига боғлиқ равишда лаборатория ишларинифизика 

лаборатория стендларида бажариш каби анъанавий шаклини сақлаб 

қолиш-қолмаслик масаласи фаол муҳокама қилинмоқда. Айниқса бу 

кўпинча механик маятник, транзистор, электр занжир ва шу каби содда 

объектларга оид бўлиб, улар учунмавжуд математик моделлар 

ўрганилаётган жараёнларни адекват баён этадилар.  Шунга боғлиқ 

равишда қимматбаҳо, қўпол, аксарият ҳолларда кўп энергия талаб 

қиладиган ва мураккаб  физика лаборатория стендларидан тўлиқ воз кечиш 

таклиф этилмоқда. 

Бироқ, ўқув тажриба тадқиқотини қўйиш заруратини ўрганиш 

объектининг мураккаблиги ва унинг математик модели бор-йўқлиги эмас, 

балки буни техник, муҳандис, илмий ходимни тайёрлаш стратегияси 

тақозо этади. Техник адабиётларни ўқиш, электр ва монтаж схемаларини, 



 
 

конструкторлик ҳужжатларини тушуниш, текширув ва лойиҳа ҳисоб-

китобларини ўтказиш маҳорати, моделлаштириш аппаратидан  фойдалана 

олиш каби кўникма ва маҳоратлар билан бирга бўлғуси мутахассис 

мажбурий тартибда муҳандислик тажрибасини қўйиш ва ўтказиш 

техникасини ўрганган бўлиши шарт. Бусиз техника ва технологиялар 

соҳаси мутахассиси бўлиш жуда қийин. Ахир у янги физик жараёнларни 

ўрганиш учун тадқиқотчилик ускуналари, янги яратилган техник 

маҳсулотлар сифатини баҳолаш учун лаборатория стендлари яратиши, 

заводнинг туркумли маҳсулотини қабул қилиш-топшириш синовлари учун 

технологик стендларяратиши керак бўлади. 

Айнан оддий ва турли-туман ўқув объектларида ўқувчи, талаба 

муҳандислик тажрибасини қўйиш маҳоратини эгаллаши ва бу маҳоратни 

ўз амалий фаолиятида моделли баёни мавжуд бўлса ҳам, анча ноаниқ 

бўлган янги ва мураккаб объектларни яратишда омилкорлик билан 

қўллаши талаб этилади. Бу ҳолда тажрибани йўлга қўйишда тажриба 

маълумотларига кўра математик моделнинг тузилмаси ва параметрларини 

белгилаш ва аниқлаштириш асосий вазифа бўлиб, яъни математик модел 

тузилмаси ёки параметрларини идентификациялаш масаласи ҳал қилинади  

[5]. 

 

1.3. Микропроцессорқурилмаларини ўрганиш бўйича лаборатория 

практикумининг таълимий вазифалари 

 

Лаборатория практикумига қуйидаги муҳим вазифалар юкланади: 

Олинган назарий билимларни амалда мустаҳкамлаш. Физик 

жараённи унинг математик баёни орқали тушуниш бир нарса бўлса, 

реалтехник қурилмада унинг намоён бўлишини кўриш бутунлай бошқа 

ҳодиса. Фақат ана шундай бирлик ўрганилиш объекти тўғрисида тўлиқ ва 

яхлит тасаввур ҳосил қилишга кўмаклашиши лозим. Тажриба ҳамиша 

ҳақиқат мезони бўлиб келган. 



 
 

Реал ускуналар билан мустақил ишлаш кўникмаларига эга бўлиш. 

Бу бўлғуси касбнинг турли ўқув фанларини ўрганишда мунтазам амалга 

оширилганида, аста-секин танланган касбга, соҳага кириб бориш ҳисси 

пайдо бўлади, «темирга қўл теккизиш»дан қўрқув ҳисси йўқолади. 

Муҳандислик экспериментини режалаштириш ва уни қўйиш. Уни 

нимадан бошлаш керак? Қандай натижаларни кутиш лозим? Қайси 

параметрларнива қай кўламда ўзгартириш талаб этилади? Қайси чиқиш 

кўрсаткичлари ва қандай аниқлик ва тезлик билан назорат қилиниши 

керак? – мана шу саволларни мустақил амалий фаолиятда ҳал қилиш керак 

бўлади. 

Тажриба ўтказиш учун ускуналарни танлаш. Зарур ускуналар 

ҳамиша ҳам қўл остида бўлавермайди. Уни нима билан алмаштириш 

мумкин ва бу алмаштириш тўлақонли, мақбул бўла оладими? Танлаш 

имконияти анча катта бўлганида, иқтисодий мақсадга мувофиқлик 

масалалари келиб чиқади. Танлай ола билиш керак ва буни ҳам ўрганиш 

талаб этилади. 

Тажриба натижаларига ишлов бериш ва уларни изоҳлаш. Тажриба 

ўтказишнинг ўзи – анча қиммат бўлса ҳам, ҳали ишнинг ярми холос. Бироқ 

натижаларда ҳақиқат топа олмасангиз, сарф-харажатлар зое 

кетади.Ҳақиқат эса шовқин ва халақитлар ортида «яшириниб», уни 

танлашда адашиш ҳеч гап эмас. Шундай бўлиб чиқмаслиги учун, тажриба 

натижаларигастатистика ишлови беришнинг замонавий математик 

услубларини ўрганиб олиш керак. 

Назарий таҳлил натижаларини тажриба маълумотлари билан 

солиштириш. Бу муҳандислик тажрибасидаги энг муҳим ва энг мураккаб 

вазифа бўлиб, тажриба айнан шу мақсад учун мўлжалланган. Тажриба 

ўтказувчи тадқиқ этилаётган физик жараён хусусида бошланғич тасаввурга 

– бошланғич математик моделга эга бўлиши шарт. Хўш, у қанчалик тўғри? 

Агар унча тўғри бўлмаса, у ҳолда тажриба натижаларига кўра унга 

тузатиш, тўғрилаш киритиш мумкинми? Ана шунда 



 
 

тажриба(эксперимент)мақсади ва унга кетган харажатлар ўз-ўзини 

оқлайди. 

Идеал таълим жараёни вазиятида ўқув материалини ўзлаштириш 

самарадорлигини ошириш мақсадида ўқув фани доирасидаги ҳар бир 

ўрганилиш объекти назарий, амалаий, моделли ва тажрибавий тадқиқ 

этишнинг барча зарур компонентлари билан мажбурий тартибда 

таъминланиши шарт. [6] 

 

I боб бўйича хулоса 

Юқорида келтирилган масалаларнинг натижалари бўйича яратилаётган 

темир автоматикаси ва телемеханикаси микрпроцессор қурилмаларини 

ўрганиш бўйича лаборатория мажмуасини яратишда қўйиладиган асосий 

талаблар ажратиб олинди. Бунда энг асосий эътибор илғор педогогик 

ўқитиш технологияларини қўллаган ҳолда методик кўрсатмалар 

мажмуасини ишлаб чиқиш зарурияти тахлил қилинди. Микропроцессор 

қурилмаларини ўрганиш учун зарур бўлган лаборатория жихозлари, 

макетлари ва стендлари тузилмаси, улар билан ишлаш кўникмалари ҳақида 

баён этилди. 

 

  



 
 

II боб. Виртуаллаборатория ишларини ишлаб чиқиш 

 

2.1. Виртуаллаборатория ишларини ишлаб чиқишмасаласини 

тадқиқ этиш  

 

Виртуал лаборатория практикуми–лаборатория машғулотларини 

ўтказишнинг тараққий этаётган илғор турларидан бири бўлиб, унинг 

моҳияти реал лаборатория тадқиқотини ўрганилаётган физик жараёнларни 

ўқувчининг лаборатория ускуналари билан виртуал ишлаши асосидаги 

математик моделлаштириш билан алмаштиришдан иборат бўлади. 

Қўлланилаётган дастурий воситалар муҳитига боғлиқ равишда реал 

объектлар билан ишлаш яхши иллюзиясини яратиш мумкин. 

Виртуал лаборатория практикумларининг икки принципиал 

кўринишини фарқлайдилар: 

 буткул моделлилаборатория практикуми, у бошидан тормоз 

ускуналари натижалар олинганга қадар универсалёки махсус ишлаб 

чиқилган компьютер моделлари воситасида рўёбга чиқарилади; 

 тўлиқ натурадаги лаборатория практикуми, у ўз постановкасида 

моделли воситаларга таяниб, натижалар эса реал амалга оширилган 

тажрибалар маълумотлар базасидан олинади. 

Замонавий имитацион компьютер моделлариимкониятлариреал 

ускуналар билан ишлаш ҳақиқий ҳиссини, иллюзиясини яратади. Бундай 

ёндашувнинг ижодий жиҳати бўлиб, у ҳар бир таълим олаётганга ўз 

индивидуалижодий имкониятларини намоён қилишга йўл очиб беради. 

Виртуал лабораторияга кириб, виртуал асбоблар ва ускуналар танлаб 

олиш, виртуал стенддаўз индивидуал вазифасига кўра тажриба схемасини 

йиғиш, турли берилган параметрлар ва чеклашлар билан тадқиқ этилаётган 

физик жараённинг изланиш моделлаштирилишини ўтказиш, узундан-узоқ 

ҳисоб-китоблар ва график қуришларга куч сарфламай, тадқиқот 

натижаларига ишлов бериш мумкин бўлади. 



 
 

Маълумотлар базасидан реал тажрибалар натижаларини олиш таълим 

жараёнига бирор янгилик киритмайди, чунки таълим олаётган шахс 

лаборатория ускуналарининг айнан ўзининг, ҳатто улар нотўғри бўлса ҳам, 

ҳаракатларига нисбатан реакциясини кўриши, сўнг уни қайта фикрлаб, 

тузатишлар киритиши ва такрорий тажриба ўтказиши зарур.Бироқ унинг 

ҳар қандай ҳаракатларига жавобан компьютер тизими тажрибали ўқитувчи 

томонидан олинган битта-юбитта тўғри жавобни «тўғри келтириб» 

қўйганида эса, талаба унга таълим беришмаётганини, балки “чиройли 

алдашаётганини” англаб етади ва ечимни излаш каби ижодий жараёнги 

қизиқишини йўқотади. 

Шундай қилиб, ўрганилаётган физик жараёнларни компьютерда 

моделлаштиришзамонавий таълим жараёнининг мажбурий таркибий 

қисми бўлиб, аммо у тўлиғича реал лаборатория практикумининг ўрнини 

боса олмайди. 

Масофали лаборатория практикуми–лаборатория машғулотларини 

ташкил этишнинг истиқболли турларидан бири бўлиб, у очиқ техник 

таълим тизимида мустақил ўқитиш учун тавсия этилади. Унинг моҳияти 

узоқдаги фойдаланувчиларнинг компьютер тармоқлари 

бўйичамутахассислар тайёрлашнинг базавий ресурс марказларида 

жойлаштирилган автоматлашган ўқув стендлари (комплекслари) жамоавий 

фойдаланишларини таъминлашдан иборат. 

Шу типдаги лаборатория ускуналари ва дастурий-методик 

воситалартаълим олаётган шахснинг индивидуал вазифасига кўра кўплаб 

муқобил вариантлар ичидан ўрганиш объектини танлаш, унинг 

параметрларини созлаш, берилган схемани ва тажрибани ўтказиш 

режимларини конфигурациялаш, тажриба натижаларига ишлов бериш ва 

уларнинг қатъий математик баҳосини амалга ошириш имконини 

берадилар.Бу ерда лаборатория практикуми зиммасига қўйилган таълим 

функциялари мажмуи тўлиқ ҳажмда амалга оширилади. 



 
 

Масофали лаборатория практикуми оппонентлари ўрганилаётган реал 

объект ва барча лаборатория ускуналари билан ўқувчи ўртасида бевосита 

жисмоний контактнинг иложи йўқлигини унинг асосий камчиликларидан 

бири деб кўрсатадилар. Бундан келиб чиқиб, лаборатория практикумининг 

асосий таълим функцияларидан бири –реал ускуналар билан мустақил 

амалий ишлашнинг кўникмаларига эга бўлиш каби функциясига риоя 

қилнмайди. Шу масала юзасидан баъзи эътирозларимиз бор: 

ўрганилаётган объект билан тўғридан-тўғри жисмоний контакт асосан 

тренажерларда муҳим бўлиб, бу ерда у мураккаб қўл ёрдамида (масалан, 

автомобилни) бошқаришда ҳаракатлар координациясини яхшилаш учун 

объектив тарзда зарур ҳисобланади. Аксарият ҳолларда объектни билишда 

(ўрганишда) тўғридан-тўғри контакт деярли ҳеч нарса бермайди. 

Ўрганилаётган физик жараёнлар (электр, магнит, иссиқлик 

гидродинамиква б.), одатда, объектнинг ташқи қобиғи ортида яширин ва 

уларни инсоннинг сезги органлари орқали бевосита ҳис қилиб бўлмаслиги 

сабабли, тўғридан-тўғри контакт фойдасиз бўлади; 

дастлабки автоматлаштириш воситалари пайдо бўлганидан кейин 

бошқариш оператори аста-секин объетни бевосита бошқариш контуридан 

чиқарилиб, вақт ўтиши билан унинг ўрнини бошқарувчи машина эгаллади, 

чунки оператор сезги органлари ва реакцияси бошқаришнинг сезуачанлик, 

аниқлик, тез ҳаракат қилиш ва кўп каналлилиги талабларига жавоб бермай 

қўйди. Шу сабабли масофадан туриб бошқариш шаклларига ўтиш билан 

операторни (экспериментаторни) бошқарув (ўрганиш) объектидан 

узоқлаштириш жараёни даврнинг объектив талабларидан бири бўлиб 

келади; 

замонавий саноат ишлаб чиқариши автоматлашган бошқарув 

тизимлари асосига қурилган. Муҳандис-технолог технологик жараёнларни 

бевосита цехда эмас, балки диспетчерлик хонасидан туриб назорат қилади. 

Реал ишлаб чиқаришни масофали мониторинг қилиш унинг асоси бўлиб, 

техник ускуналарни масофадан туриб бошқариш технологияларини 



 
 

мустаҳкам эгаллаган мутахассисларни тайёрлаш долзарб вазифалардан 

бирига айланиб бормоқда. 

Мавжуд лаборатория практикумлари билан ўтказилган таҳлил 

кўрсатишича, деярли ҳар бир таълим муассасасида объектив зарур эмас, 

балки тасодифий тарзда шакллантирилган, техник мутахассисларни 

тайёрлаш бўйича ягона давлат тизимини амалга ошириш имконини 

бермайдиган лаборатория базасидан фойдаланилиб, у техник 

мутахассислар тайёрлашнинг ягона давлат тизимини амалга ошириш 

имконини бермайди. Объектив равишда лабораториятадқиқотлари 

ўтказиш ҳамда концепция киритилиши ва янги авлод 

лабораторияускуналарининг татбиқ этилишини тартибга соладиган  

меъёрий ҳужжатларни яратиш амалиётини қайта кўриб чиқиш зарурати 

юзага келмоқда. 

 

2.2. PIC микроконтроллерларини дастурлаш муҳитини ўрганиш 

бўйича виртуал лабораторияишларини ишлаб чиқиш 

 

Виртуал лабораторияиши Windows иловаси базасида MPLAB 

ихтисослашган дастурий пакетидан фойдаланган ҳолдаамалга оширилган. 

Ушбу ишни бажаришда ўқувчилар микропроцессорли қурилмалар 

ишининг услубиётини ўзлаштириб олишлари талаб этилади.  

Ушбу лабораторияишида микроконтроллер асосидаги рақамли 

қурилмалар ва тизимларни лойиҳалаштириш ва ишлаб чиқишнинг асосий 

босқичлари кўриб чиқилиб, шунингдек аппаратлар ва дастурий 

воситаларни биргаликда созлаш услублари обзори келтирилади. 

Мазкур лаборатория иши 4 соатга мўлжалланган ва «Темир йўл 

транспортида микропроцессорли қурилмалар ва бошқарув тизимлари» 

фани дастури мазмунига мос келади.  

Мазкур лаборатория иши учунқуйидаги тизимли талабларга эга бўлиш 

зарур:  



 
 

процессор - PIV 1.8 МГцдан юқори;  

ОХҚ (ОЗУ) - камида256МБ ; 

эркин бўшлиғи бўлган қаттиқ диск - камида100МБ;  

тармоқ адаптери 10/100Мб/с;  

принтер.  

Керакли (исталган) дастурий талаблар:  

NT оиласига мансуб ОС MS Windows;  

MSOffice: MSWord, MSExcel дастурлар пакети;  

Талаб қилинган ОС дистрибутиви таркибига кирган "Блокнот" дастури;  

MS Internet Explorer версияси–камида6.0. 

MPLABIDE 8.0 ихтисослашган дастурий муҳити  

 

Интеграциялашган MPLAB ишлаб чиқиш муҳитини ўрганиш 

Ишдан мақсад:ОМТ бўйича лаборатория макети ва MPLAB ишлаб 

чиқиш муҳити билан танишиш. 

ОМТ бўйича лаборатория макетиўз ичига PIC16F873A 

микроконтроллери асосидаги кўргазма платасини, PICkit 2 созлаш-

дастурини ва MPLAB дастури ўрнатилган шахсий компьютерни олади. 

Макетнинг бир корпусида икки комплект аппаратура (икки иш жойи). 

Макетнинг тузилиш схемаси 2.1-расмда келтирилган. У 

PIC16F873Aмикроконтроллери, унга уланган периферия қурилмалари, 

PICkit 2 созлаш-дастури ва шахсий компьютердан иборат. 

Периферия қурилмалари таркибига қуйидагилар киради: 

– SA1 «RESET» тугмачаси (сброс); 

– микроконтроллер параллел порти киришларига уланган SA2..SA6 

тугмачалари; 

– микроконтроллер аналог-рақамли ўзгартиргичи киришига улаб 

қўйилган потенциометр R1; 

– пьезокерамик товуш тарқатгич (чиқаргич) BZ1; 



 
 

– микроконтроллерпараллелпортининг чиқишларига уланган 

HL1...HL6 ёруғлик диодлари; 

–микроконтроллер кенглик-импульсли модулятори чиқишига уланган 

PV1микроамперметри; 

– олдинма-кетин интерфейс драйвери RS-232C (ILX232Nтипидаги 

DD2микросхемаси), умикроконтроллер вашахсий компьютер олдинма-

кетин порти чиқишларидаги сигналлар даражаларини мувофиқлаштириш 

учун мўлжалланган; 

– олдинма-кетин порт бўйича ахборот узатилиши ёки қабул 

қилинишини индукциялайдиган HL8 «TXD» ва HL9 «RXD» ёруғлик 

диодлари. 

PICkit 2 дастур-созлагич дастурнинг ижро этилаётган иккиталик 

кодини  микроконтроллернинг ички FLASH хотирасига дастурлаш 

режимида ёзиб олиш ҳамда маълумотларнинг энергияга боғлиқ 

хотирасини, умумий ва махсус мақсадлар учун кўзланган регистрларни 

ўқиш, шунингдек дастур ишини созлаш режимида бошқариш учун 

мўлжалланган. 

Принципиал электр схема бевосита макетнинг олди панелида ва 2.1-

расмда келтирилган. 

 
2.1-расм. Макетнинг тузилмавий схемаси 



 
 

Microchip Technology Incorporated фирмасининг PIC-micro 

микроконтроллери учунмўлжалланган MPLAB IDE интеграцияланган 

ишлаб чиқиш муҳити дастур матнини ёзиш, мослаштириш ва 

оптималлаштириш имконини беради. MPLABIDE ўз ичига матн 

муҳаррири, Ассемблер MPASM тилидан компиляторни, MPLINK объект 

файлларини компановкаловчи (линковкачи), MPLIB кутубхоналари 

компановкаловчиси, лойиҳалар менежери, MPLABSIMсимулятори ва 

бошқа зарур дастурларни олган. Бундан ташқари, MPLABда Microchip 

фирмаси ва бошқа ишлаб чиқувчилар томонидан ишланган PICkit, MPLAB 

ICD, MPLAB ICE каби дастурлаш ва созлаш аппарат воситалари билан 

ишлаш таъминланади. MPLAB да ахборотга ишлов бериш тузилмавий 

схемаси 2.2-расмда келтирилган.Дастурнинг Ассемблер тилидаги 

дастлабки матни кўриниши .asm кенгайтмаси билан файлда (файлларда) 

сақлаб қўйилиши шарт. Дастурни MPASM дастури ёрдамида машина 

кодларига компиляция қилишда объект файллари .о кенгайтмаси билан 

генерацияланади. MPLINK компоновкачиси мавжуд объект файлларини ўн 

олтита рақамли машина кодли ва .hex кенгайтмасига эга бўлган файлга 

бирлаштириб, бундадастлабки дастурнинг ҳар бир фрагментига хотира 

соҳаси ажратилиб, белги (метка)ларга муайян адреслар берилиши юз 

беради ва ҳ.к. 

Шакллантирилаётган .hex-файлгакутубхона файлларида .lib 

кенгайтмаси билан сақланаётган дастурнинг тайёр фрагментлари ҳам 

киритилиши мумкин. .hex-файл дан ташқари MPLINK .lst кенгайтмасига 

эга бўлган дастурнинг тўлиқ матнига эга бўлган файлни (листинг), .map 

кенгайтмали дастур хотирасини тақсимлаш режаси бўлган файлни 

вакомпиляцияда аниқланган хатоликлар тўғрисидаги .err кенгайтмасига эга 

бўлган файл-ҳисоботни ҳам генерациялайди.Ўн олтита рақамли кодларга 

асосланган дастур (hex-файл) микроконтроллернинг дастурий имитаторига 

(симуляторига) жойланиши ёки аппарат программатори ёрдамида бевосита 

реал микроконтроллернингички FLASH хотирасига киритилиши мумкин. 



 
 

Лаборатория макетидадастурни созлашнинг ҳар иккала варианти мумкин 

бўлиб, бироқ симуляторни созлашда микроконтроллерга уланадиган реал 

қурилмалар билан ишлаш имконияти бўлмайди. 

Тайёр объект файлларидан кутубхона модулларини яратиш учун 

MPLIB кутубхоналар муҳарриридан фойдаланилади. 

 
2.2-расм. MPLAB да ахборотга тузилмавий ишлов бериш 

 

Ассемблертилидаги дастурнинг бошланғич матни тузилмаси 

жадвалдан иборат бўлади (2.1-жадв.қар.). Жадвал устунлари оралиқ ёки 

табуляция рамзлари билан ажратилган бўлишлари шарт. Дастурнинг ҳар 

бир сатри сохта (псевдо) команда деб номланган, MPASM компилятори 



 
 

томонидан ассемблер ёки линковкачига директива (кўрсатма)га 

айлантириладиган битта ассемблер командасига эга. 

Сохта(псевдо)командалар машина кодларига трансляция қилинмайди. 

Биринчи устунда микроконтроллер дастурлари хотирасида мазкур 

команданинг адресларининг рамзли (символли) белгиланишидан иборат 

бўлган белги (метка) жойлашади. Белги (метка)албатта ҳарфдан ва 

сатрнинг бош қисмидан бошланиши керак бўлиб, икки нуқта билан тугаши 

шарт. Белгилар (меткалар)дастурнинг у ёки бу ерига қулай ишора қилиш, 

кўрсатиш учун мўлжалланган, масалан қуйидагича ёзиш  

GOTO start 

ўрнига 

GOTO 0x0002 

Иккинчи устун ассемблер командасининг (сохта команда) мнемоник 

кодига эга. 

Учинчи устун – мазкур командада ишлов бериладиган маълумотлар, 

улар операндлар деб аталади. Агар команда бир неча операнддан 

фойдаланса, бу ҳолда улар вергул билан ажратилади, агар команда 

операндларни қўлламаса, учинчи устун бўшлигича қолаверади.  

Тўртинчи устун  мажбурий эмас ва ўз ичига мазкур командага матнли 

шарҳни олган. Шарҳ рамз (символ) дан (вергулли нуқта) бошланади. Шарҳ 

мазмуни компилятор томонидан эътиборга олинмайди ва дастур ишига 

таъсир кўрсатмайди. 

MPLAB замонавий версияларида дарчали интерфейсни қўллаш 

дастурни яратиш жараёнини анча соддалаштирди. Файлларни зарур 

форматга ўзгартириш ва тегишли дастурларни чақириш автомат тарзда, 

деярли дастурчи аралашувисиз рўй беради. MPLAB интерфейсибошқа 

Windows иловалар интерфейсига ўхшаб кетади ва ўзлаштирилиши осон. 



 
 

Ассемблер тилидаги дастурнинг дастлабки матнига мисол 2.1-жадвал

 

 

 

 

 

 

 

 

 

 

 

MPLAB асосий дарчасининг скриншоти 2.3-расмда келтирилган. 

Инструментлар панелидаматнли меню асосий функцияларини 

такрорлаб келган олтита гуруҳ тугмачалари бор: 

– стандарт тугмачалар, файлларни бошқариш, таҳрир қилиш, чоп этиш 

каби  тугмачаларини ўз ичига олган; 

– лойиҳалар менежери; 



 
 

– назорат суммаси; 

– дастурлашни бажаришни бошқариш тугмачаларини ўз ичига олган, 

созлаш; 

–PICkit 2 дастур-созлагични бошқариш; 

– дастурни созлашда фойдаланиладиган қурилма ресурслари. 

MPLAB асосий дарчасининг ишчи соҳасида очиқ файлли дарчалар, 

сузиб чиқадиган менюлар, диалог дарчалари ва бошқа ахборот 

жойлаштирилади. 

Ҳолат сатри тизимнинг жорий созланганлигини ҳамда ишлаб 

чиқилаётган дастурнинг асосий маълумотларини акс эттиради. 

 
2.3-расм. MPLABасосий дарчаси: 1 – меню панели, 2 –инструментларпанели, 

3 – ишчи соҳа ва 4 – ҳолат сатри 

 

 



 
 

Ишни бажариш услубиёти  

1. Янги лойиҳани яратиш  

Менюдаги Project › New... банд танлаб олинсин ёки сичқончанинг чап 

клавишаси билан инструментлар панелидаги тегишли тугмачага 

чертилсин. Шунда пайдо бўлган, скриншоти 2.4-расмда келтирилган 

диалог дарчасида дастурнинг номини ва лойиҳанинг ишчи файллари 

сақланадиган папкага йўл кўрсатилиши шарт. Дастурнинг номини ва 

папкага йўлни кўрсатишда фақат лотинча ҳарфлар, рақамлардан 

фойдаланиш талаб этилиб, орада бўш жойлар қолдирилмаслиги керак. OK 

клавишасига чертилади. 

 
2.4-расм. «Янги лойиҳа» диалог дарчаси 

 

2. Дастурнинг бошланғич матнига эга бўлган файлни яратиш  

МенюдагиFile › New банди (пункти) танланиб, ёки  

инструментларпанелидаги тегишли тугмача босилсин. MPLAB ишчи 

соҳасида матн муҳаррири дарчаси очилиб (2.5-расмга қар.), унинг 

ёрдамида ўз дастурининг матнини териш мумкин бўлади.Биринчи 

лаборатория ишида Windows алмашинув буфери орқали ана шу дарчага, 

масалан test_all.asm файлидан тайёр дастур матнини нусха кўчириб олиш 

мумкин. 

Дастурнинг бошланғич матнини лойиҳанинг ишчи папкасида .asm. 

кенгайтиришли файлда сақлаб қўйилсин (File › Save As...). 

 



 
 

 
2.5-расм. MPLAB матн муҳаррири дарчаси 

 

3. Файлни лойиҳага қўшиб қўйиш  

Лойиҳалар менежери дарчаси (View › Project) очилсин (2.6-расмга 

қар.).Сичқончанинг ўнг клавишаси билан Source Files папкасига чертиб, 

тушиб қоладиган меню Add Files... банди (менюси) пункти танлансин. Бу 

ҳолда 2.7-расмда келтирилган файлни очиш диалог дарчаси очилади. Зарур 

файлни танлаб олиш ва Очиш клавишасини босиш талаб этилади. 



 
 

 
2.6-расм. Лойиҳалар менежери дарчаси  

 
2.7-расм. Файлни лойиҳага қўшиш дарчаси  



 
 

4. Дастур бошланғич матнини машинали кодларга 

компиляциялаш 

Дастурни компиляциялашдан аввал MPLAB микроконтроллери 

типиникўрсатиш зарур. Бунинг учун менюдаги Configure › Select Device... 

бандни (пунктни) танлаш ва очилган  диалог дарчасида (2.8-расм) қурилма 

типини танлаш талаб этилади. Бу ҳолда у PIC16F873A. 

 
2.8-расм. Микроконтроллерни танлаш дарчаси 

 

Микроконтроллернинг конфигурацион ячейкасига киришConfigure › 

Configuration bits менюси орқали амалга оширилади. Конфигурация 

битлари дарчаси кўриниши 2.9-расмда кўрсатилган. Лаборатория 

макетидатактли сигнал манбаи сифатида юқори частоталикварцли 

резонатор қўлланса, биринчи сатрнинг Setting устунида HS Oscillator (2.9-



 
 

расмга қар.) пунктини танлаш керак бўлади. Қолган пунктлар мазмунини 

ўзгартиришсиз қолдириш ҳам мумкин. 

Конфигурацион ячейкаларнисозлашнинг муқобил усули бошланғич 

коддаги директивалар билан созлаш ҳисобланади. Масалан, юқорида 

келтирилган созлашни бажариш учун (кварцлигенератордан тактли 

генератор сифатида фойдаланиш) бошланғич матн бошида қуйидаги 

директивани жойлаштириш етарли: 

__CONFIG _HS_OSC; 

Бунда Configuration Bits дарчасидаги «Configuration Bits set incode» 

байроқчаси ўрнатилган бўлиши шарт. Бошланғич матн файлини ўн олтита 

рақамли .hex-файлга айлантириш учун менюдаги Project › Make пунктни 

танлаш, ёки инструментлар панелидаги тегишли тугмачага чертиш талаб 

этилади. Бунда лойиҳанинг ишчи папкасида .o, .hex, .lst, .map, .err 

кенгайтмалари билан чиқиш файллари яратилади. 

 
2.9-расм. Конфигурация битлари дарчаси 

 

Ушбу файллар мазмунини MPLAB матн муҳаррири дарчасида кўриб 

чиқиш мумкин (File › Open..., ёки инструментлар панелидаги тугмача). 

Компиляциянинг бажарилиш жараёни вааниқланган хатоликлар 

тўғрисидаги хабарлар MPLAB чиқиш дарчасида акс эттирилади (2.10-

расм). 



 
 

 
2.10-расм. MPLAB чиқиш дарчаси 

 

5. Дастур кодини микроконтроллернинг ички FLASH хотирасига 

киритиб (ёзиб) қўйиш  

Микроконтроллерни дастурлаш вадастурни созлаш учун лаборатория 

макетида PICkit 2 дастур-созлагич қўлланиб, у шахсий компьютернинг 

USB портига уланган бўлиши шарт. MPLAB га PICkit 2 дан созлагич 

сифатида фойдаланиш кўрсатмаси менюдаги Debugger › Select Tool › PICkit 

2пункти (банди) орқали берилади. PICkit уланганидан сўнг менюдаги 

дастурлаш командалари ва инструментлар панелидаги уларга тегишли 

тугмачалардан фойдаланиш имкони пайдо бўлади. Дастурни 

микроконтроллер хотирасига киритиб (ёзиб) қўйиш Debugger › Program 

командаси томонидан, Debugger › Read, энергия жиҳатидан мустақил 

маълумотлар хотирасини ўқиш эса – Debugger › Read EEDATA командаси 



 
 

томонидан бажарилади. Микроконтроллерни муваффақиятли дастурлаш 

натижаси ёки бунда юзага келган хатоликлар MPLAB чиқиш дарчасида акс 

эттирилади. 

 

6. Дастурни созлаш (бажариш) 

Дастур бажарилишини бир неча режимларда ишга тушириш мумкин. 

Бунинг учун менюда тегишли командаларва инструментлар панелидаги 

тугмачалар кўзда тутилган. Debugger › Run дастурни реал вақт режимида 

ишга тушириб юборади. Кварцли резонатор частотаси 4 МГц бўлганида 

бир команданинг бажарилиш вақти роппа-роса 1 мксга тенг. Debugger › 

Animateдастурни мультипликациярежимида ишлатиб юборади. 

Команданинг бажарилиш вақти тахминан 0,5 с ни ташкил қилиб, бу 

дастурнинг бажарилиш жараёнини кузатиб бориш имконини беради. 

Debugger › Step Into асосий дастурдаги вакиритилган кичик дастурлардаги 

битта навбатдаги команданинг бажарилишига олиб келади. Debugger › Step 

Over ҳам шунга ўхшаш тарзда, аммо кичик дастурларни бажармаган ҳолда 

ишлайди. Навбатдаги бажарилаётган команда курсор биландастур 

матнидан чап тарафда жойлашган яшил стрелка кўринишида белгиланади. 

Дастурнинг бажарилиши Debugger› Haltкомандаси билан, шунингдек 

менюнинг Debugger › Breakpoints... командасида бериладиган тўхтатиш 

нуқтасида аввалдан белгиланган тугмача ёрдамида ёки сичқонча 

клавишасининг дастур бошланғич матнининг керакли сатрига икки марта 

чертиш билан тўхтатилиши мумкин. Тўхтатиш нуқтаси дастур матнидан 

чап тарафида В ҳарфи туширилган қизил доира шаклида акс эттирилади. 

Ноактив тўхтатиш нуқталари қизил доиралар кўринишида акс эттирилади. 

Отладка (созлаш) вақтида микроконтроллер хотираси ва унинг ички 

ўрнатиладиган периферия қурилмаларида дастур томонидан амалга 

ошириладиган ўзгаришларни кузатиш мумкин. Бунинг учун MPLAB ишчи 

соҳасидаги тегишли дарча очилиши талаб этилади. 



 
 

View › Disassembly Listing командасишу номдаги дарчани очиб (2.12-

расм), унда дастур хотирасининг машина кодлари ва командаларнинг 

мнемоник белгиланишлари кўринишидаги мазмуни акс эттирилади. View › 

EEPROM маълумотларнинг энергия жиҳатидан боғлиқ (тобе) бўлмаган 

дарчасини очади (2.11-расм). View › File Registers маълумотлар хотираси 

дарчасини очади (2.13-расм). View › Hardware Stack аппарат стеки 

дарчасини очади (2.14-расм). View › Program memory – эса дастурлар 

хотираси дарчасини очади (2.15-расм) ва ҳ.к. 

 
2.11-расмЭнергияга боғлиқ бўлмаган маълумотлар хотираси дарчаси 

 
2.12-расм. Дизассемблер дарчаси 



 
 

 
2.13-расм. Маълумотлар хотираси дарчаси 

 
2.14-расм. Аппарат стеки дарчаси 

 
2.15-расм. Дастурлар хотираси дарчаси 



 
 

Ҳисобот мазмуни  

Ҳисоботда дастурни ёзиш ва отадка қилиш (созлаш) бўйича турли 

босқичлар учун MPLAB дастури асосий дарчасининг скриншотини 

(скриншотларини) келтириш талаб этилади (ўқитувчи берган вазифа 

асосида). 

Назорат саволлари 

1. MPLAB дастури нима учун мўлжалланган? 

2. asm-файл ўз ичига нималарни олган? .hex-файл-чи? 

3. Энергия жиҳатидан мустақил ДХҚ(ПЗУ) ячейкаларини кўриб чиқиш 

учун қайси дарчани чақирасиз? 

4. Созлашжараёнида сиз 0x73 адреси бўйича хотира ячейкасининг 3 бит 

ҳолатини кузатишингиз керак. Сизнинг ҳаракатларингиз. 

5. Тасаввур қилинг, дастурингиз реккурентҳисоб-китоб билан 

шуғулланаяпти (уни амалга ошириш учун циклдан фойдаланиш талаб 

этилади). 

Ҳисоблаш тугатилганидан сўнг унинг натижалари киритиш/чиқариш 

қурилмаларига чиқарилади ва созлаш жараёнида сиз ҳисоблаш 

натижаларини назорат қилиб боришингиз шарт.Нимадан фойдаланасиз: 

тўхташ нуқтаси биланми ёки анимация билан? 

6. Лаборатория ишида тактли генераторни созлаш конфигурацион 

ячейкаси кўриб чиқилган эди. Яна қандай конфигурацион ячейкалар 

мавжуд? Улар нима учун мўлжалланган? 

7. Микроконтроллер тактли частотаси манбаларини санаб ўтинг 

вауларни MPLAB да танлашнинг икки усулини кўрсатинг. 

 

  



 
 

2.3.Микроконтроллерларни аппаратли дастурлаш қурилмасини 

ўрганиш бўйичавиртуаллабораторияни ишлаб чиқиш  

 

Ушбу бобда PICKit 2программатор/созлагичи билан қандай қилиб 

ишни тез бошлаш баён этилган. Микроконтроллерларни аппаратли 

дастурлаш қурилмасини ўзлаштириш учун қуйидаги вазифалар кўриб 

чиқилади: 

 pickit 2 ни улаш; 

 дастурий таъминотни ўрнатиш; 

 дастурланаётган микросхемага уланиш; 

 таъминотни бошқариш; 

 .hex файлини импорт қилиш; 

 дастурлаш; 

 верификация; 

 микроконтроллер хотираси мазмунини ўқиш; 

 кодни ҳимоялаш; 

 хотирани ўчириш ва унинг тозалигини текшириш; 

 автомат тарздаги дастурлаш/ўқиб олиш; 

 pickit 2 ни калибровкалаш; 

 

PICkit 2программатор-созлагич обзори 

PICkit 2 ишлаб чиқувчининг программатор-созлагичи нисбатан арзон 

ишлаб чиқиш воситаси бўлиб, у Microchip Technology Inc компанияси 

ишлаб чиқарган аксарият микроконтроллерлар, хотира микросхемаларива 

KeeLOQ дастурлашларини қўллаб, улар билан ишлай олади. Қўлланадиган 

микросхемаларнинг тўлиқ рўйхатини олиш учун PICkit 2 Starter Kit 

дискидаги README файлига мурожаат қилинг. 

Янги микросхемалар билан ишлаш имконияти (қўллаш) PICkit 2 

дастурий таъминоти янгиланишлари чиққанида қўшиб қўйилиши мумкин. 



 
 

PICkit 2 дастурий таъминотининг сўнгги версияларини Microchip 

компанияси сайтидан олиш мумкин:www.microchip.com/pickit2 

 
2.16-расм. PICkit 2программатори. 

1. Ҳолат ёруғлик диодлари 

2. Тугмача 

3. USB кабелни улаш учун разъем 

4. Биринчи чиқиш жойи маркери 

5. Дастурлаш қурилмасини улаш учун разъем (ажратгич)  

 

PICkit 2 mini-B типидаги USB разъемга эга. Етказиб бериш 

комплектидаги кабелдан фойдаланиб, PICkit 2 ни компьютерга уланг. 

Ҳолат ёруғлик диодлари PICkit 2программатор/созлагич статусини акс 

эттирадилар. 

Power (яшилёруғлик диоди) PICkit 2 ҳам USB портга уланганлигини 

кўрсатади. 

Target (сариқёруғлик диоди) PICkit 2 мақсадли қурилмага таъминот 

узатаётганини кўрсатади  

Busy (қизилёруғлик диоди) PICkit 2 бандлигини вадастурлаш, 

текшириш каби вазифаларни бажараётганлигини кўрсатади. 

Тугмача мақсадли қурилма дастурлашини ишга тушириш учун ҳам 

ишлатилиши мумкин бўлиб, бунинг учун Programmer>Write on PICkit 

Buttonпунктида (бандида) белги қўйиб қўйинг. 



 
 

Тугмачашунингдек PICkit 2 ни юклаш режимига киритиш учун ҳам 

қўлланиши мумкин бўлиб, бу режимда PICkit 2программатори дастурий 

таъминотини янгилаш имкони бор. 

Дастурловчи разъем мақсадли қурилмани улаш учун 6 та чиқиш 

жойига эга. Чиқиш жойлари вазифалари 2.17-расмда кўрсатилган. 

 
2.17-расм. Дастурлаш разъеми(ажратгичи). 

Чиқиш жойлари вазифалари: 

1. VPP / MCLR 

2. VDD мақсадли қурилманинг таъминот кучланиши  

3. VSS ер 

4. ICSPDAT / PGD 

5. ICSPCLK / PGC 

6. AUX 

PICkit 2 Programmer дастурий таъминоти PICkit 2программатори 

қўллаб-қувватлайдиган барчамикросхемаларни дастурлаш имконини 

беради. Дастур интерфейси 2.18-расмда келтирилган. 



 
 

 
2.18-расм. программы PICkit 2 Programmer дастури интерфейси. 

 

Ишни бошлаш  

PICKit 2ни улаш 

PICKit 2 ни шахсий компьютергаетказиб бериш комплектига кирадиган 

USB кабели ёрдамида уланг. 

PICKit 2 ни 6-контактли разъем (ажратгич) ёрдамида мақсадли платага 

уланг. 

Программаторни ишлаб турган USB-портга ҳали уланиб улгарилмаган 

ташқи таъминотдан ток оладиган мақсадли платага улаб қўйманг. 

PICKit 2 ни USB га улашдауни мақсадли платадан узиб қўйиш тавсия 

этилади. ШК ни ўчириб-қайта ёқишда ҳам шу каби тавсияга амал қилиш 

керак.  

Дастурий таъминотни ўрнатиш  

CD-ROM PICkit 2 Starter Kit ни юритма ичига жойланг, ўрнатиш 

дастури автомат тарзда ишлаб кетади. Агар ўрнатувчи ишга тушмаса – 

қўлда PICkit_Starter_Kit_Welcome.htm файлини очинг. Дастурий 



 
 

таъминотнинг энг янги версиясини доим www.microchip.com/pickit2 

сайтидан олиш имкони мавжуд. 

Ўрнатишдан сўнг PICkit 2 Programmer дастурини ишга туширинг. 

Қобиқнинг ташқи кўриниши 2.19-расмда келтирилган. 

 
2.19-расм.PICkit 2 Programmer дастури қобиғи. 

 

Дастурланадиган микросхемага уланиш 

PICKit 2 программатори Microchip PIC микроконтроллерлари ва 

EEPROM хотира микросхемаларининг кўпгина қисмини дастурлашни 



 
 

қўллай олади (мос тушади).Қўлланадиган (мос келадиган) қурилмалар 

рўйхати ўрнатиш CD сида readme файлида бўлади ёки Help→Readme 

менюсидан чиқариб (чақириб) олинади. 

Дастурни ишлатиб юборишда уланган контроллер типи автомат тарзда 

аниқланиб, Configuration дарчасида акс эттирилади (2.20-расм). 

 
2.20-расм. Уланган контроллерни аниқлаш. 

Агарқурилма аниқланмаган бўлса – таъминловчи кучланиш узатилиши 

ҳамда мақсадли платага уланиш ишончлилигини текширинг. 

Device Family менюсидан фойдаланиб, исталган вақтда сизга керакли 

туркумни (оилани) танлаб олиш мумкин, бунда PICKit 2 мақсадли қурилма 

билан уланишга ҳаракат қилиб кўради (2.21-расм). 

 
2.21-расм. Выбор программируемого семейства 



 
 

Baseline туркуми (оиласини), шунингдек KEELOQ® ва EEPROM 

микросхемаларини танлашда, шу билан бирга тушиб қоладиган рўйхатдан 

муайян (аниқ) буюмни (маҳсулотни) танлаш талаб этилиб (2.22-расм), 

чунки бу микросхемаларда идентификационбитлар (device ID) йўқ. 

 
2.22-расм. Базавий туркум (оила) контроллерларини танлаш. 

.hex файлларни импорт қилиш 

Прошивка файлини импорт қилиш учун .hex форматидаFile→Import 

HEX менюсидаги пунктни танлаб олинг. Агар прошивка файлидабирон-

бир конфигурацион битлар мавжуд бўлмаса, қобиқ огоҳлантиришюборади. 

Жорий прошивкани .hex файлга тўғри сақлаб қўйиш учун MPLAB IDE 

қобиғи менюсидан File→Exportни танлаб олинг. 

 
2.23-расм. hex файл ни импорт қилиш. 

Микросхемаларни дастурлаш 

Микросхемалар туркуми тўғри танланиб, прошивка файли импорт 

қилинганидан сўнгмақсадли микросхемани Write тугмачаси билан 

дастурлаш имконияти пайдо бўлади (2.24-расм). 

 



 
 

 
2.24-расм. Қайд этиш тугмачаси. 

Микросхема ўчирилиб, юкланган прошивка билан дастурланади. 

Микроконтроллернинг аксарият қисми умумий ўчириш (Bulk Erase) 

режимини қўллаб, у минимал таъминот кучланишида ҳам ишлаб,  

контроллерларнинг бошқа қисмиблокли ўчиришни (Row Erase) қўллайди. 

Блокли ўчириш амалиёти умумий ўчиришга нисбатан кўпроқ вақт олади, 

аммо уни таъминот кучланиши паст бўлганида ҳам бажариш мумкин. 

PICKit 2 умумий ўчириш имконияти бўлмаган ҳолларда автомат тарзда 

блокли ўчиришга ўтади. Агар микроконтроллер блокли ўчиришни 

қўлламаётган бўлса – огоҳлантириш берилади. Блокли ўчиришни 

қўллайдиган контроллерлар рўйхатини readme файлидан олиш мумкин. 

Дастурлаш амалиётининг бориши статус сатрида акс эттирилади. 

Дастурлаш муваффақиятли якунланган ҳолатида сатр яши рангга киради 

ва унда Programming Successful деган ёзув пайдо бўлади (2.25-расм). 

 
2.25-расм. Ёзув киритишнинг муваффақиятли тугалланиши. 

 

Хато қилинган ҳолда сатр қизил тус олиб, унда Programming Failed 

деган ёзув пайдо бўлади (2.26-расм). Бундай ҳолда дастурлаш амалиётини 

яна бир марта қайтариб кўринг. 



 
 

 
2.26-расм. Дастурлашдаги хатолик. 

 

Бошқа ҳолларда статус (мақом) сатри сариқ рангга киради ва унда 

огоҳлантириш сабаби кўрсатилади, масалан,мақсадли қурилма билан 

уланиш йўқ (2.27-расм). 

 
2.27-расм. Ёзув пайтидаги огоҳлантириш. 

 

Хотиранинг муайян бўлимини дастурлаш  

Агар микроконтроллер ички EEPROM хотирасига эга бўлса, у ҳолда 

унинг дастурланиши микросхеманинг умумий дастурланиш жараёнида 

ўчирилиши ҳам мумкин. Қўлда ўчиришда бутун хотира ҳажми ўчириб 

юборилади. Бўлимнинг танланиши, дастурлашдан ташқари, шу тарзда 

верификация ва ўқиб олиш амалиётларига ҳам таъсир кўрсатади. 

 



 
 

Прошивка файлининг автомат тарзда юкланиши  

Ҳар бир дастурлаш олдидан (Write тугмачаси босилиши билан) қобиқ 

автомат тарзда импорт қилинган файл .hex санасини худди шу файлнинг 

дискдаги санаси билан солиштириб текширади. Агардискдаги файл 

нисбатан янгироқ бўлса, у ҳолда ушбу файл автомат тарзда импорт 

қилинади (кўчириб олинади). 

Мазкур хусусият MPLAB IDE томонидан генерацияланган энг янги 

прошивкадан автомат тарзда, шу жумладан Program on PICkit Button иш 

режимида ҳам, яъни қобиқ дарчасига кўчмаган ҳолда, шунчаки 

программатор корпусидаги тугмачасини босиш билан фойдаланиш 

имконини беради. Ушбу иш режимиTools→Program on PICkit 

Buttonменюсида созлаб олинади. 

Прошивкани верификациялаш 

Верификация функцияси импорт қилинган .hex файллимикросхеманинг 

мазмуни билан амалга оширилади. Дастурлар хотираси, EEPROM, 

идентификация битлари ва конфигурация битлари солиштирилади. 

Менюнинг Programmer→Verify on Write  пунктида дастурлашда 

автоматверификацияни созлаб олиш мумкин. 

 
2.28-расм. Верификация тугмачаси. 

Агар верификация муваффақиятли ўтган бўлса, ҳолат сатри яшил тус 

олиб, унда Device Verified ёзуви пайдо бўлади. Агарномувофиқлик 

аниқланса, у ҳолда сатр қизил рангга кириб, унда номувофиқлик юз берган 

хотира соҳаси ёзиб қўйилади. 

Прошивкани ўқиш 

Микросхемадан прошивкани ўқиш Read тугмачасини босиш билан 

бажарилади. Хотира соҳалари мазмуни тегишли дарчаларда акс 

эттирилади. Агар дастурлашда микросхема учункод ҳимояси ўрнатилган 

бўлса, у ҳолда ўқиб (санаб) олишда ноллар ўқиб (санаб) олинади. 



 
 

 
2.29-расм. Ўқиш тугмачаси. 

Кодни ҳимоя қилиш 

Микроконтроллер дастурлари хотираси ва EEPROM маълумотлари 

хотираси имеет ўқиб олишдан ҳимояга (код ҳимояси) эга. Ҳимоя қилиш 

учун қуйидагилар зарур: 

Прошивка файлини импорт қилиш. 

Код ҳимоясини (Tools→EnableCodeProtectменюси, 2.30-расм) 

ва/ёкиEEPROMҳимоясини (Tools→EnableData Protectменюси)ёқиш 

Микросхемани дастурлаш  

Хотиранинг ҳимояланган соҳаларига мурожаат қилишда программатор 

нолларни ўқиб олади (санаб олади). Прошивкангиздан ҳимояни олиб 

ташлаш учун код ҳимояси ва EEPROM ни ўчириш ҳамда микросхемани 

қайта дастурлаш талаб этилади. 

 
2.30-расм. Код ҳимоясини ишга тушириш (ишлатиб юбориш). 

 

 



 
 

II боб бўйича хулосалар 

Магистрлик диссертациясининг ушбу бобида микрокнтроллерлар учун 

дастурий таъминот яратиш ишчи дастурлари хақида баён этилди. 

Microchip PIC контроллерларига дасту тузиш дастурий таъминоти билан 

ишлаш кўникмаларини талабаларда ҳосил қилиш мақсадида виртуал 

лаборатория иши ишлаб чиқилди. Энг асосий эътибор MPLAB дастурий 

муҳити билан ишлаш ва ишлаб чиқилган дастурни микроконтроллерларга 

юклаш бўйича амалий кўрсатмалар берилди. 
  



 
 

III БОБ. Универсал микропроцессорли модул асосида Microchip 

PIC микроконтроллерларини ўрганиш бўйича лаборатория ишлари 

комплексини ишлаб чиқиш 

 

3.1. PIC-microмикроконтроллерларининг хотира қурилмаларини 

ўрганиш бўйича лаборатория ишини ишлаб чиқиш. 

 

PIC-micro микроконтроллерларининг хотира қурилмаларини 

ўрганиш 

Ишнинг мақсади: PIC16F873A микроконтроллерининг ишлаш  ва 

дастурлаш хотирасини ўрганиш. 

PIC16F873A микрокотроллерининг таркибига тўрт хил кўринишдаги 

хотира қурилмалари киради: 14 разрядли FLASH дастурлаш хотираси, 

ҳажми 4096 сўз, 192 ячейкали 8 разрядли статик оператив маълумотлар 

хотираси, 128 ячейкалик 8 разрядли энергияга боғлиқ бўлмаган EEPROM 

маълумотлар хотираси ва саккиз босқичли аппаратли хотира. 

FLASH дастурлаш хотираси 

Хотира дастури дастурда ишлатиладиган кодларнинг ва ўзгармас, яъни 

константа маълумотларни сақлаш учун мўлжалланган.  FLASH дастурлаш 

хотирасидан маълумотларни ўқиш ва ёзиш аналогик тарзда энергияга 

боғлиқ бўлмаган EEPROM маълумотлар хотирасидаги маълумотларни 

ўқиш ва ёзиш каби амалга оширилади ва улар қуйида муҳокама қилинади. 

FLASH хотирадан дастурни ёзиб олиш дастур-тузатувчи PICkit 2 ёрдамида 

амалга оширилади, бунинг учун микроконтроллернинг учта киритмаси 

ишлатилади: PGD – маълумотлрни киритиш, PGC – синхронлашни 

киритиш ва PGM – паст кучланишли дастурлаш режимини танлашни 

киритиш. 

PIC16F873A микроконтроллерининг дастурлаш хотира картаси 3.1-

расмда келтирилган 



 
 

 
3.1-расм FLASH хотира дастурининг тузилиши 

Оператив хотира маълумотлари – рўйхатланган файл 

Оператив хотира маълумотлари микроконтроллер ишлаётган 

малумотларни сақлаш учун мўлжалланган. 

Маълумотларни ўқиш ва ёзиш маълумотлар хотирасида 

микроконтроллернинг ўзида ихтиёрий буйруқни бажаришда ишлаб 

чиқилади, амалда  умумий ёки махсус тайинланган регистрлар сифатига 

эга бўлади. Маълумотлар хотирасига икки хил усул билан мурожаат 

қилиш мумкин: бевоита ва билвосита. Бевосита адреслашда адрес ячейка 

хотираси тўғридан-тўғри операнда буйруқларида кўрсатилади. Билвосита 

адреслашда ҳақиқий адрес ячейка хотираси FSR регистр адресига 

жойлаштирилади, буйруқнинг ўзида эса жисмонан амалда бўлмаган INDF 

регистри операнда сифатида кўрсатилади.Ҳамма хотира қурилмалари 

умумий ва махсус танланган регистрлар орасида тўртда банкка бўлиниб 

тақсимланади. Биринчи 32 та ячейка ҳар бир банкдаги МТР остида 

заҳираланади, 96 ячейка эса 0-банкда ва 1-банкда УТРни банд қилади. 

STATUS регистрининг мос разрядларининг ўзгаришлари орқали фаол 

банкни танлаш амалга оширилади: RP0 ва RP1 бевосита адреслашда, ёки 

IRP билвоситада. 

 

 



 
 

 
3.2-расм Оператив хотира маълумотлари тузилиши 

Оператив хотира маълумотлари картаси 3.2-расмда келтирилган 

Таъкидлаш керак МТРга мурожаат қилишда дастурда уларнинг 

ҳақиқий ўн олтилик адресининг йўлини кўрсатиш мумкин, шундай 

уларнинг ҳарфий белгиларининг йўлларини ҳам кўрсатиш мумкин. 

Оҳиргии ҳолатда дастурнинг бошланғич матнига Ассемблернинг 

#includep16f873a.inc  кўрсатмасини фаоллаштириш зарур, берилган 

микроконтроллер учун уланган файлларнинг ҳарфий ифодалари ва сон 



 
 

қийматлари мос келиши тушиши керак. МТРнинг ҳарфий белгиларини 

алоҳида битларда ифода қилиш мумкин. 

Энергияга боғлиқ бўлмаган EEPROM маълумотлар хотираси 

Энергияга боғлиқ бўлмаган EEPROM маълумотлар хотираси 

микроконтроллернинг электр манбаи ўчганида ҳам сақланиб қолиши керак 

бўлган маълумотларни сақлаш учун мўлжалланган. EEPROM хотирага 

FLASH билан таққосланганда сон жиҳатидан устига кўп марта ёзиш 

мумкин. Ўчириш/ёзишнинг минимал цикли EEPROMда 100 мингни 

ташкил этади, FLASH хотирада эса – ҳаммаси бўлиб 1 минг. 

EEPROM хотира картаси 3.3-расмда келтирилган 

 
3.3-расмЭнергияга боғлиқ бўлмаган EEPROM маълумотлар хотирасининг 

тузилиши 
EEPROM маълумотлар хотираси ва FLASH дастурлаш хотирасидан 

маълумотларни ўқиш ва ёзиш учун махсус танланган регистрлар 

ишлатилади: EEDATA – маълумотлар регистри (14 разрядли хотира 

дастурларига мурожаат этишдаги кичик байтли маълумотлар), EEDATH – 

хотира дастурига мурожаат этишдаги катта байтли маълумотлар, EEADR – 

адреснинг регистри (4Кб хотирали дастурига мурожаат этишдаги кичик 

байтлар адреси), EEADRH –хотира дастурига мурожаат қилишдаги катта 

байтлар манзили, EECON1 – биринчи бошқарув регистри,EEPROM 

(FLASH), EECON2 – иккинчи бошқарув регистри,EEPROM (FLASH), 

INTCON – танаффуслар бошқаруви регистри, PIE2 – танаффусга рухсат 

берувчи иккинчи регистр ваPIR2 – танаффус байроқларининг иккинчи 

регистри. 

EEPROMдан маълумотларни ўқиш учун, қуйидаги ишлар кетма-

кетлигини бажариш зарур: 



 
 

–EEADR регистри хотирасидаги зарур ячейкалар адресларини ёзиб 

олинади; 

– EEPGDEECON1 регистрида «0» битга келтирилади; 

– EECON1 регистрида RD «1» битини ўрнатиш билан ўқиш 

операцияси бошланади; 

– EEDATA регистридан олинган маълумотларни ҳисобланади. 

FLASH хотира дастуридан маълумотларни ўқиш аналогик тарзда 

амалга оширилади, ишларнинг кетма-кетлиги озгина қийинроқ: 

– кичик байтли зарур бўлган ячейкаларни EEADR регистридан, катта 

бўлганини эса  EEADRH регистридан ёзиб олиш; 

– EEPGD  EECON1 регистрида «1»  бит ўрнатилади; 

– EECON1 регистрида RD «1» битини ўрнатиш билан ўқиш операцияси 

бошланади; 

– иккита машинасозлик циклиниг узилиш вақт узунлигини 

шакллантириш, мисол учун  иккита салт NOP буйруғини бажариш йўли; 

– EEDATA регистридан кичик байтдаги, EEDATH регистридан эса 

катта байтдаги олинган маълумотларни ҳисобланади. 

EEPROMдан ёзиб олинадиган маълумотлар кетма-кетлиги қуйидагича: 

1. EECON1 регистридаги WR битининг ҳолатини текшириш ва «0» га 

тенглигига ишонч ҳосил қилиш, яъни ҳозирги вақтда EEPROM ёки 

FLASHда ёзиб олиш жараёни йўқ.  

2. EEADR регистридаги керакли ячейкага адресни ёзиш. 

3.  EEDATAдаги ячейкага маълумотларни ёзиш 

4. EEPGD  EECON1 регистрида  «0»  битга келтирилади. 

5. EEPROMда ёзиб олишга рухсат берувчи, EECON1 регистрига WREN 

«1»  бити ўрнатилади. 

6. Агар уларга рухсат берилган бўлса, танаффусни тақиқлаш. 

7. Бешта командалар кетма-кетлиги албатта бажарилиши керак. 

–EECON2 регистридаги H'55' қийматини ёзиб олиш (иккита команда, 

дастлаб Wдаги, кейин EECON2даги). 



 
 

–EECON2 регистридаги H'AA' қийматини ёзиб олиш (иккита команда, 

дастлаб Wдаги, кейин EECON2даги). 

–EECON1 регистрида   WR«1»  бити  ўрнатилади. 

8. Агар зарурат бўлса, танаффусга рухсат бериш. 

9. EECON1 регистрида WREN«0» бит тозаланади. 

10. Ёзиш циклининг охирига келиб автоматик тарзда EECON1 

регистрининг  WR«0» бититозаланади ва  PIR2 регистрида EEIF узилиш 

ишораси  «1»да кузатилади. 

Стек 

Стек деб, “биринчи кириб – оҳирги чиққишни” ташкил қилиш 

томоилига асосланган оператив хотира доирасига айтилади. PIC16 

микроконтроллерида стек фақат дастур остидан қайтган адресларни 

сақлаш учун ишлатилади. Бошқа микропроцессор ва 

микроконтроллерлардан фарқли равишда, PIC16 микроконтроллерида 

маълумотларни стекка ёзиш кўзда тутилмайди. Стекли хотрада бўш 

ячейканинг навбатини танлаш автоматик тарзда амалга оширилади, 

дастурда стекнинг кўрсаткичи мавжуд эмас.  

Стекда ҳаммаси бўлиб, статик оператив хотиранинг саккизта 13-

разрядли ячейкалари мавжуд (3.4. расм), шунингдек PIC16 

микроконтроллери учунёзилган дастурда киритиладиган дастур остилар 

саккизтадан ошмаслиги керак, танаффус ишчилари(драйверлар) ҳам шулар 

жумласидан. 

 

 
3.4-расм Стекли хотира тузилиши 

 

 



 
 

Ишни бажариш тартиби 

Ушбу лаборатория ишида дастурни қайта ишлаш ва тузатиш, 

PIC16F873A микроконтроллернинг аниқланган хотира хажмига 

мурожаатни амалга ошириш зарур. Муайян вазифани ўқитувчи беради. 

Вазифа сифатида қуйидаги вазифаларни кўрамиз: дастурни 

қайтаишлаш, 0-банкдаги барча умумий танланган регистрларни h'00' дан 

бошлаб ўсувчи тартибда тўлдириш ва EEPROM га ушбу маълумотларни 

кўчириш зарур. 

 

1.Қўйилган вазифа 

Аналитик кўринишда масалининг бошланғич оғзаки шаклини тақдим 

этамиз. Бунинг учун регистрлар навбатини қайд қиладиган сонини N 

ҳарфи билан, регистрнинг адресини F ҳарфи билан, EEPROM ячейкаси 

адресини эса E ҳарфи билан белгилаймиз. 0-банкда УТР адреси H'20' дан 

бошланиб, H'7F' тугайди, F ⊂[H'20', H'7F'] шаклида ёзиш мумкин. Ушбу 

хотира массивида мос равишда H'00' дан H'5F' гача ёки N ⊂[H'00', H'5F'] 

сонлар мосланади. EEPROMга  нусха олишда  E ⊂[H'00', H'5F'] 

адреслардаги ячейкаларга иштирок қилади. Ҳудди шундай [F0]=0, [Fi]=Ni, 

[Fi+1]=Ni+1, [Ei]=[Fi] ёзиш мумкин. 

Охирги формуладаги квадрат қавслар F ва E ҳарфлари билан 

белгиланган хотира ячейканинг адреси эмас, балки ушбу адресдаги хотира 

ячейканиинг мазмунини билдиради. 

 

2. Дастурнинг алгоритмини ишлаб чиқиш 

Дастурнинг кенгайтирилган алгоритми 3.5-расмда келтирилган. 



 
 

 
3.5-расм Дастурнинг блок-схема алгоритми 

Алгоритмнмнг биринчи блогида Ассемблер дастурининг бошланғич 

созламаси ишлаб чиқилади: асосий файлнинг матни ссилкага боғланади, 

дастурнинг бошланғич адреси берилади, УТР тақсимланади ва бошқалар. 

Иккинчи блокдан еттинчигача 0-банкдаги регистр файлларининг 

ўсувчи сонлари ёзилади. 



 
 

Иккинчи ва учиничи блокда ячейка адресининг бошланғич оператив 

хотира маълумотлари ва сони берилади, ушбу ячейкага ёзилади. 

Тўртинчи блокда хотира ячейкасидаги хусусий ёзишлар сони ишлаб 

чиқилади. 

Бешинчи ва олтинчи блокларда кейинги ячейка ва кейинги сон адреси 

ҳисобланиши ишлаб чиқилади (берилган мисолда оддийгина бирга 

оширилган). 

Алгоритимнинг  еттинчи блогида сонни уни оҳирги қиймати билан 

таққослаш бажарилади. Қуйидагаларни ҳисобга олсак, шу берилган 

мисолда таққослаш сонлар катталашгандан кейин амалга оширилади, 

шунинг учун соннинг оҳирги қийматини 5F деб эмас, 60 сифатида оламиз. 

Агар сон ўзининг оҳирги қийматига етмаса, унда дастур ушбу сон ёзилган 

навбатдаги ячейкага қайтади (4-блок, М10:), агар таққослаш натижаси 

қониқарли бўлса, дастур ОҲҚ (ОЗУ)дан маълумотларни EEPROM га 

кўчиришга ўтади (саккизинчи блокдан ўттизинчигача). 

Саккизинчи ва тўққизинчи блокларда оператив хотира маълумотлари 

ва EEPROMдаги ячейкалар адресларининг бошланғич қиймати берилади. 

Ўнинчи блокда навбатдаги ячейкалар ОҲҚ (ОЗУ)дан EEPROMга 

маълумотлар кўчириш бажарилади. 

Ўн биринчи ва ўн иккинчида ОҲҚ (ОЗУ) ва EEPROM ячейкалар адреси 

биттага ошиб боради. 

Ўн учинчи блокда EEPROM ячейкалар адреси билан биттага ошадиган 

оҳирги қийматлар таққосланади. Агар ячейка адреси ўзининг оҳирги 

қийматига етмаса, дастур 10-блокка қайтади (М20:), бошқача айтганда – 

дастурнинг оҳирига ўтади. (ИЛОВА 1) 

4. Дастурнинг бошланғич матнини ҳисоблагич кодларига ўгириш 

Янги лойиҳа ва тўпламлар дастурини тузиш жараёни II бобда батафсил 

ёзилган. 

 

 



 
 

5. Тест ўтказиш ва тузатиш 

Дастурни тузатиш босқичида аввалги босқичларда пайдо бўлган барча 

хатоларни аниқлаш ва бартараф этиш зарур. Микроконтроллернинг 

дастурини ёзиш ва дастурни ишга тушириш жараёни II бобда келтирилган. 

Шуни ҳисобга олиш зарурки, энергияга боғлиқ бўлмаган EEPROM 

маълумотлар хотираси фақат Debugger › Read EEDATA буйруғи 

бажарилганидан кейин кўрсатилган. 

Кузатиш  

ОМТ курсини ўрганишда ишлаб чиқиладиган барча дастурлар соф 

таълимий кўринишга эга бўлганлиги сабабли, уларнинг ишлаш 

имкониятини фақат лаборатория ишини ўқитувчига топшириш вақтига 

қадар сақлаб туриш керак бўлади, холос. 

Ҳисоботнинг мундарижаси 

Ҳисоботда берилган масалани, алгоритмнинг блок-схемаси ва 

Ассемблер тилида ёзилган тузатиш босқичида топилган тузатишлар билан 

дастур матнини келтириш зарур. 

Назорат саволлари 

1. PIC16F873A микроконтроллерида қанақа кўринишдаги хотиралар 

иштирок этади? 

2. Дастурларнинг тузилишида маълумотлар хотирасини банкларга 

таысимланиши бир қатор қийинчиликларни туғдиради: дастурчи доимий 

равишда хозир қайси банк билан ишлаётганини ҳақида ёдида тутиши 

керак, берилган назорат решистрининг аниқ бир битини ўрнатиш учун 

қайси банкка ўтиш кераклигини ҳам унитмаслиги керак. Бироқ PIC16 

микроконтроллерининг маълумотлар ҳотираси банкларга бўлингандир. 

Сиз нима деб ўйлайсиз нега микроконтроллер яратувчилари бундай йўл 

тутишган? 

3. Алгоритмнинг биринчи бўлимида EEPROM (FLASH) га ахборот 

ёзилиши EECON1 регистрининг WR байроғи орқали текширилади, яъни 



 
 

хозирги вақтда микроконтрллер EEPROM (FLASH) хотирасига ахборот 

ёзиш билан банд эмаслигига ишонч хосил қилишимиз керак. 

4. Қайси қўлланмалар PIC16 комплектидан маълумотларни стекка 

ёзади ва маълумотларни ундан ўчиради? 

5. Нима учун стек хотира 13-разрядли ўлчамда бўлади? 
 

3.2. PIC-microмикроконтроллерларининг параллел порларини 

ўрганиш бўйича лаборатория ишини ишлаб чиқиш 

 

PIC-microмикроконтроллерларининг параллел порларини 

ўрганиш 

Ишнинг мақсади: PIC16F873A микроконтроллерининг параллел 

портларини ишлашини ва дастурлашни ўрганиш. 

PIC16F873A микроконтроллерида учта параллел кириш-чиқиш 

портлари бор: 6 разрядли А порти ва иккита саккиз разрядли В ва С 

портлари. Ташқи қурилмаларга кириш-чиқиш портлари мос равишда 

RA0...RA5, RB0...RB7 ва RC0...RC7 чиқишлари орқали уланади. 

А порти чиқиш мултиплексорли киришдан рақамли-аналог тўғирлагич 

билан, В порти пастволтли дастурлаш схемаси (дастур-тузатувчи PICkit 2 

ишлатилади) билан ва киришдан танаффус сўрови билан, С порти эса – Т1 

интервал таймерининг схемаси билан, кенг-импулсли модуляторнинг 

кетма-кет шиналари ва кетма-кет портлари. Бундан ташқари В портининг 

киришидан ички тортувчи резисторлар улаш мумкин. 

Лаборатория макетининг схемасида параллел портлар чиқиши 

қуйидагича тақсимланган: RA0 – аналог-рақамли тўғирлагич кириши, RA2 

ва RA3 – пьезокерамик овоз тарқатувчига уланган чиқиши BZ1, RA5 – 

юқоридаги сариқ светодиод HL1, RC0 – яшил светодиод HL2, RC1 – қизил 

светодиод HL3, RC2 –КИМ чиқиши, RC3 – пастги сариқ светодиод HL4, 

RC4 – яшил йўл-йўл чизиқ HL5, RC5 – ойсимон-оқ светодиод HL6, RC6 – 

кетма-кет кириш-чиқиш портларининг чиқиши, RC7 – кетма-кет кириш-



 
 

чиқиш портларининг кириши, RB0 –  SA6 кнопка, RB1 –SA5 кнопка, RB2 

– SA4 кнопка, RB3 – пастволтли дастурлаш кириши, RB4 –SA3 кнопка, 

RB5 – SA2 кнопка, RB6 – PICkit 2 дастур-тузатувчисининг синхронизация 

кириши ва RB7 – PICkit 2 дастур-тузатувчисиниг маълумотлари кириши. 

Кириш-чивиш портларининг ишлашини бошқариш учун қуйидаги МТР 

ишлатилади: 

TRISA, TRISB ва TRISC кириш-чиқиш портлпри орқали 

маълумотларни узатиш йўналишини аниқлайди, логик «0» ни ёзишда TRIS 

регистрининг қайсидир разряди мос равишда кириш-чиқиш портларининг 

разряди чиқиш бўлиб ишлашни бошлайди, «1» ни ёзишда эса – кириш 

бўлиб. Эслаб қолиш осон: «0» худди «O» – «Output», «1» худди «I» – 

«Input». 

PORTA, PORTB ва PORTC – кириш-чиқиш портлариниг регистрлари, 

агар  порт маълумотларни чиқаришга созланган бўлса, унақада «0» ёки «1» 

ёзишда аниқланган разряд ушбу регистрлар параллел портларининг 

чиқишида вужудга келадиган мос сигналларига ўтказилади, агар портлар 

маълумотларни киритишга мосланган бўлса, унақада ушбу 

регистрларнинг, параллел портларнинг киришида қатнашувчилари билан 

ҳақиқий мантиқий босқичи бир ҳил деб санаш мумкин (ушбу регистрларга 

аввал ёзилганига қарамасдан). 

ADCON1 А портининг чиқишларидан қайси бири аналог сигналларини  

киртиш учун, қайсилари рақамли сигналларни киритиш ёки чиқариш учун 

ишлатилишини аниқлайди, берилган макетнинг схемасига аналог сигнал 

RA0 чиқишидан келади, шунинг учун А портини ишлатилишдан аввал 

кириш-чиқиш порти сифатида ADCON1регистрига H'0E' сонини ёзиб 

қўйиш зарур. 

OPTION_REG В портининг ички тортувчи резистори чиқишига улашга 

рухсат беради ва RB0 чиқишида олдинги ёки кейинги фронтдаги 

импулснинг ташқи чақириқни тўхташини аниқлайди. OPTION_REG.-

RBPU «0» разрядини қайта ўрнатишда ички тортувчи регистрини ёқишга, 



 
 

«1» ни  ўрнатишда эса – ўчиришга олиб келади, OPTION_REG.INTEDG 

разрядида «0» - орқа фронтдаги сигналининг RB0 киришда,  «1» - 

олдиндагисини тўхтади. 

Ишни бажариш тартиби 

Берилган лаборатория ишида дастурни ишлаб чиқиш ва тузатиш, 

PIC16F873A микроконтроллерининг кириш-чиқиш портларига 

мурожаатни амалга ошириш зарур. Аниқ вазифани ўқитувчи тарқатади. 

Мисол сифатида кейинги масалани кўриб чиқамиз. Бошланғич ҳолатда 

барча светодиодлар узилган, товушли сигнал етказилмаётган бўлади. SA2 

кнопкани босгандан кейин 1 кГц частотали товушли сигнал берилади. SA3 

кнопкани босгандан кейин қизил светодиод миганияли режимида уланади. 

SA4 кнопкани босгандан кейин схемабошланғич ҳолатига қайтади. 

Муаммонинг баёни 

Муаммонинг бошланғич оғзаки формасини ўтиш графиги кўринишида 

келтирамиз (3.6 расм). 

.  
3.6-расм Дастурнинг ўтиш графиги 

Дастурнинг алгоритмини ишлаб чиқиш 

Асосий дастурнинг кенгайтирилган алгоритми 3.7-расмда келтирилган. 

Дастурда бир неча бор вақтни узиш блоги ишлатилади, келтирилган кетма-

кетликдаги буйруқлар дастур ости кўринишида қайдланган, 3.8-расмда 

келтирилган алгоритм. 



 
 

 
3.7-расм Асосий дастурнинг блок-схема алгоритми 

Алгоритмнинг биринчи блогида матнли файл МТР белгили ишоралар 

билан уланади, ишорали номлар учта умумий танланган регистрлардан 

танланади, вақтни санаш ролини бажаради, қайта ўрнатиш векторининг ва 

асосий дастурнинг бошланғич адреси берилади, параллел кириш-чиқиш 

портларининг мос тушувчи ишлаш режимида созланиши ишлаб чиқилади. 

А ва С портлари, светодиодларга ва пьезокерамик овоз тарқатувчига 

уланган бўлади, маълумотлар чиқишига созланади, В порти эса кириш 



 
 

кнопкалари контакларига уланади. В порти чиқишлари ички тортувчи 

резисторга уланади. 

Иккинчидан бешинчига бўлган блоклар мос равишда устуннинг 

бошланғич ҳолатини ифодалайди. Иккинчи ва учинчи блокларда 

светодиодларнинг ўчиши ва овоз тарқатувчини ўчиришни амалга оширади. 

Тўртинчи ва бешинчи блокларда кнопка контактларининг ҳолатининг 

сўрови ишлаб чиқилади. Агар SA2 ва SA3 кнопка контактлари узилган 

бўлса, унақада дастур М10-белгига қайтади ва жараён бошидан 

такрорланади. Агар SA2 кнопка босилган бўлса, М30-белгига ўтиш амалга 

оширилади, агар SA3 босилган бўлса, унақада – М20 га. Олтинчидан ўн 

биринчигача блоклар қизил светодиоднинг миганияси учун жавоб беради. 

Олтинчи блокда светодиодга таъминот узатиш бўлади. Еттинчи блок 

дастур остига 1с. вақт давомида ушланишга чақиради. Саккизинчи блокда 

светодиод таъминотдан узилади. Тўққизинчи блок дастур остига 0,5с. вақт 

давомида ушланишга чақиради. Ўнинчи ва ўн биринчи блокларда кнопка 

контаклари ҳолати сўрови ишлаб чиқилади. Агар SA2 ва SA4 кнопка 

контактлари узилган бўлса, унақада дастур М20-белгига қайтади ва жараён 

бошидан такрорланади. Агар SA2 кнопка босилган бўлса, М30-белгига 

ўтиш амалга оширилади, агар SA4 босилган бўлса, унақада – М10га. 

Ўн иккинчидан ўн еттинчигача блоклар овозли сигналнинг юборилиши 

амалга оширилади. Ўн иккинчи блокда овоз тарқатувчига бериладиган 

олдинги фронт импулси шаклланади. Ўн учинчи блок дастур остига 0,5с. 

вақт давомида ушланишга чақиради. Ўн тўртинчи блокда овоз 

тарқатувчига бериладиган орқа фронт импулси шаклланади. Ўн бешинчи 

блок яна дастур остини 0,5с. вақт давомида ушланишга чақиради. Ўн 

олтинчи ва ўн еттинчи блокларда кнопка контаклари ҳолати сўрови ишлаб 

чиқилади. Агар SA3 ва SA4 кнопка контактлари узилган бўлса, унақада 

дастур М30-белгига қайтади ва жараён бошидан такрорланади. Агар SA3 

кнопка босилган бўлса, М20-белгига ўтиш амалга оширилади, агар SA4 

босилган бўлса, унақада – М10га. 



 
 

Дастур остини вақт узилишга чақиришдан аввал санаш-регистрида 

аниқланган соннинг қийматини ёзиб олиш зарур. Ушбу қийматларни 

ҳисоблаш методикаси пастда келтирилган. 

Биринчи бўлиб, санаш-регистрларининг сонини аниқлаш зарур. 

PIC16F873A микроконтроллерининг тактли частотаси лаборатория 

макетида 4 МГц га тенг, ҳисоблаш жараёнининг узунлиги – тактли 

частотанинг тўртдан бирига ёки 1 мкс. га тенг. Микроконтроллернинг 

кўпчилик  буйруқлари битта ҳисоблаш жараёнида бажарилади, ўтиш 

буйруқлари бундан мустасно, дастур остидан чақирув ва қайтиш иккита 

жараёнда бажарилади. Талаб қилинган жараён давомийлигини амалга 

оширишнинг энг осон йўли, кейинги буйруқларни ишлатиш: 

T10: DECFSZ CNT,F  ҳисоблагичнинг қийматини 1га камайтириш,  

     ;агар 0 кескин ўзгариш 

GOTO T10    ;ҳисоблагични камайтиришга қайтариш. 

DECFSZ буйруғи бир ҳисоблаш жараёнида бажарилади, GOTO эса 

иккита, яъни жараённи бажариш вақти 3 мкс.ни ташкил этади. Битта 

санаш-регистрини ишлатишда узилиш вақти Т ни 3 дан 3·28=768 мкс.гача 

шакллантириш мумкин, иккита санаш-регистрини ишлатишда T 

≤3·216=196 608 мкс, иккита санаш-регистрини ишлатишда T ≤ 3·224=50 

331 648 мкс ва ҳ.к. Бизниг мисолимизда учта санаш-регистри етарли. 



 
 

 
3.8-расм Дастур ости узилиш вақти алгоритмининг блок-схемаси 

Иккинчидан, ушбу регистрлардаги ҳар бир сонли қийматини ҳисоблаш 

зарур. Катта регистрдаги жараёнлар сони қуйидаги формула бўйича 

аниқланади:  

Иккинчи регистрдаги жараёнлар сони -  

Кичигида эса -  

Ҳисобланган барча жараёнлар сони, яъни олинган сон кичик томонга 

яхлитланади. 

Учинчидан, DECFSZ буйруғида аввал камайтириш бажарилади ҳолос 

ва кейин регистрнинг таркиби нол билан таққосланади (қистартиришдан 



 
 

олдин), яъни биринчи жараённинг бошида регистрда ёзилган сон, бирга 

камайтирилади, ҳисоблашда хатоликка олиб келади. Агар жараёнлар сони 

нолга тенг бўлса, бунақа ҳатолик давомий бўлиши мумкин. Шунинг учун 

ҳисобланган қийматга бирни қўшиш зарур: 

CNT_H = H +1, CNT_M = M +1, CNT_L = L +1. Бу қиймат киритилганда 

санаш-регистрида чақирувдан олдин дастур остида вақт узилади. Дастур 

ости вақт узилишининг ўзи  алгоритмининг ўн саккизинчидан йигирма 

бешинчигача бўлган блокларида қўшилади. Дастур остига кириш Т10-

белгидан амалга оширилади. Ўн тўққизинчи, йигирма биринчи ва йигирма 

учинчи блкларида санаш-регистрлари кетма-кет қистартирилиши ишлаб 

чиқилади, йигирманчи, йигирма иккинчи ва йигирма тўртинчи блокларда 

эса – ушбу санашларнинг қийматини нол билан таққосланади. Барча 

санашлар нолга тиклангандан кейин йигирма бешинчи блокда дастурдан 

чиқиш рўй беради (Илова 2). 

     

Дастур матнини ҳисоблаш кодларига ўгириш 

Янги лойиҳа ва тўпламлар дастурини тузиш жараёни 1-лаборатория 

ишида батафсил ёзилган. 

Тест ўтказиш ва тузатиш 

Дастурни тузатиш босқичида аввалги босқичларда пайдо бўлган барча 

хатоларни аниқлаш ва бартараф этиш зарур. Микроконтроллернинг 

дастурини ёзиш ва дастурни ишга тушириш жараёни 1-лаборатория ишида 

келтирилган.  

Кузатиш  

ОМТ курсини ўрганишда ишлаб чиқиладиган барча дастурлар соф 

таълимий кўринишга эга бўлганлиги сабабли, уларнинг ишлаш 

имкониятини фақат лаборатория ишини ўқитувчига топшириш вақтига 

қадар сақлаб туриш керак бўлади, холос. 

 

 



 
 

Ҳисоботнинг мундарижаси 

Ҳисоботда берилган масалани, алгоритмнинг блок-схемаси ва 

Ассемблер тилида ёзилган тузатиш босқичида топилган тузатишлар билан 

дастур матнини келтириш зарур. 

Назорат саволлари 

1. Мултиплексорнинг кириш/чиқиш портлари нима деб аталади? 

2. PORTB порти схемасининг 3 чиқишини чиқишга ростлаш учун, 

TRISB регистрига қандай қийматни ёзиш керак? 

3. Алгоритм ёрдамида узилиш вақти қандай ташкиллаштирилади? 

Микроконтроллерда узилиш вақтини ташкиллаштиришни бошқача усули 

мавжудми? 

4. Пьезотарқатувчига бериладиган овозли сигнални ташкил 

қилишқанақа шаклда рўй беради? 

5. Фараз қилайлик, микроконтроллер 200 кГц частота мосланган. Битта 

регистр-ҳисоблагич ишлатиб, қанақа максимал қийматли узилиш вақтини 

таъминлаш мумкин? 

 

3.3. PIC-micro микроконтроллерлари таймерларини ўрганиш 

бўйича лаборатория ишини ишлаб чиқиш  

 

PIC-micro микроконтроллерлари таймерларининг ишини ўрганиш  

Ишдан мақсад: PIC16F873A микроконтроллери таймерлари ишини 

ўрганиш ва дастурлаш. 

PIC16F873A микроконтроллери тўртта – TMR0, TMR1, TMR2 ва WDT 

таймерига эга. 

TMR0 таймери 8-разрядлиолдинги бўлувчи бўлган 8-разрядли импульс 

ҳисоблагичдан иборат. Ҳисоб импульслари манбаи сифатида 

импульсларининг келиш даври машина цикли(FOSC/4) давомлилига 

тенгбўлган микроконтроллернингички тактлар генератори,ёки 

микроконтроллернинг RA4/T0CKI чиқишига узатиладиган ташқи 



 
 

сигналкелиши мумкин. TMR0 таймери ёрдамида олдинги бўлувчидан 

фойдаланмаган ҳолда шакллантириш мумкин бўлган максимал вақт 

оралиғи ҳисоб импульсларининг 256 даврига, олдинги бўлувчидан 

фойдаланган ҳолда эса – 65 536 даврга тенг. TMR0 нинг яна бир хусусияти  

WDT қўриқчи таймери бўлган олдинги бўлувчидан биргаликда 

фойдаланишдан иборат. 

Таймер ишини бошқариш OPTION_REGрегистрининг олтита разряди 

ёрдамида амалга оширилади: T0SC бит ҳисоб импульслари манбаини 

танлайди, T0SE бит – ташқи ҳисоб импульсларининг олд ёки орқа 

фронтини танлайди, PSA бит TMR0 ёки WDTолдинги бўлувчини 

қўллашни белгилаб беради, учта PS0...PS2 битлари эсаолдинги 

бўлувчининг бўлиниш коэффициентини берадилар. OPTION_REG 

регистрининг муайян регистрлари қийматлари 3.10-расмда берилган. 

TMR0 таймерининг тузилмавий схемаси 3.10-расмда келтирилган. У 

ёзиб олиш учун ишлатиш мумкин бўлган ва махсус мақсадлар учун 

мўлжалланган TMR0регистр-ҳисоблагичдан, дастурий жиҳатдан ишлатиб 

бўлмайдиган (программно не доступен) 8-разрядлиолдинги бўлувчидан, 

бешта MUX мультиплексоридан, ташқи ҳисоб импульсларини синхронлаш 

SYNCузелидан,WDT қўриқчи таймериваинкорловчи ИЛИ логик 

элементидан иборат.Схема тўрт режимда ишлаши мумкин: 

–ички тактлар генераторининг олдинги бўлувчисиз импульслар 

ҳисоблагичи. Бу режимга ўтиш учун T0SC бит «0» га туширилади, PSA эса 

«1» га кўтарилади. Ички тактлар генераторининг CLKOUT 

импульслариикки мультиплексор васинхронлаш узели орқали  ўтиб, 

TMR0регистр-ҳисоблагич киришига келиб тушадилар. Таймер 

шакллантирадиган вақт интервали T нинг давомлилигиқуйидаги формула 

бўйича аниқланади: T = 28-N, бундаN – TMR0регистрига ёзиб олинган сон. 

Ҳисоблагич тўлиб кетганидан сўнг, яъни у H'FF' дан H'00' қийматига 

ўтишида, INTCON регистрида T0IF байроғикўтарилади ваагар 

INTCONрегистрининг GIE ва T0IE битлари «1» ини ўрнатиш билан рухсат 



 
 

этилган бўлса, узилиш келтириб чиқарилади. Бундан кейин 

ҳисоблагичҳисобни H'00' қийматидан бошлаб давом эттиришини (вақт 

оралиғи 256 машина цикли), яъни навбатдаги талаб этилган 

давомлиликдаги вақт интервалини шакллантириш учун TMR0 регистрга 

яна ҳисоблаб аниқланган рақамни ёзиш талаб этилади; 

 
– ички тактлар генераторининг олдингибўлувчисизимпульслар 

ҳисоблагичи. Мазкур режимга ўтиш учун PSA битга «0» ташлаш керак 

бўлади. Бунда CLKOUT импульслариаввал 8-разрядлиолдинги бўлувчи 

киришига, кейин унинг чиқишидан эса TMR0регистр-ҳисоблагичи 

киришига бориб тушади. Олдинги бўлувчининг қайта ҳисоблаш 

коэффициенти PS0...PS2 битлари билан берилади. 

Таймер шакллантирадиган вақт интервали T нинг 

давомлилигиқуйидаги формула бўйича аниқланади: T = K(28-N), бундаK –

олдинги бўлувчининг бўлиниш коэффициенти, N эса – TMR0 регистрига 

ёзиб олинган сон. Олдинги бўлувчини қўллашдавақт интервалини 



 
 

шакллантириш дискретлилиги катталашиб, у олдинги бўлувчини қайта 

ҳисоблаш коэффициентига тенг.Қолган ҳолатларда таймер иши унинг 

биринчи режимдаги ишидан фарқ қилмайди; 

– ташқи тактларимпульсларининг олдингибўлувчисизимпульслар 

ҳисоблагичи. Мазкур режимга ўтиш учун T0SC ва PSA битлар «1» га 

кўтарилади. Микроконтроллернинг T0CKI чиқишидан импульслар 

«Исключающее ИЛИ» логик элементи киришига келиб тушади.T0SE=0 

битининг ҳолатида бу импульслару орқали инверсиясиз ўтади ва TMR0 

ҳисоблагичининг навбатдаги ҳолатга ўчиб ўтиши ҳисоб импульсларининг 

олд фронти бўйлаб юз беради, T0SE=1 бўлганида эса ҳисоб импульслари 

инвертирланиб, ҳисоблагич ишлаб кетиши орқа фронт бўйлаб юз беради. 

Шундан сўнг ҳисоб импульсларииккита мультиплексор орқали ўтиб, 

синхронлаштириш схемасининг киришига тушадилар ва бу ерда уларнинг 

иккинчи ва тўртинчи машина тактларида стробирланиши юз беради. 

Шундай қилиб, ҳисоб импульсларининг келиш частотаси FOSC/2дан кичик 

бўлиши шарт. Қолган ҳолатларда таймер иши унинг биринчи режимдаги 

ишидан фарқ қилмайди; 

 
3.10-расм. TMR0 таймерининг тузилмавий схемаси 



 
 

– ташқи тактларимпульсларининг олдинги бўлувчилиимпульслар 

ҳисоблагичи. Мазкур режимга ўтиш учун T0SC бит «1» га кўтарилиб, PSA 

эса «0» га туширилади. Олдинги бўлувчининг бу режимдаги иши 2-

режимдаги каби бўлиб, ҳисоблагичнинг иши эса – 3-режимдаги билан бир 

хил. Таймер TMR1 импульсларнинг 3-разрядлиолдинги бўлувчиси бўлган 

16-разрядлиҳисоблагичи бўлиб келади. Мазкур таймернинг хусусияти 

микроконтроллернинг T1OSO ва T1OSI чиқишларига уланадиган алоҳида 

қуйи частотали кварцли резонатордан ишлаш, шунингдек 

синхронлаштириш узелини ўчириб қўйиш имконияти ҳисобланади. 

Юқорида санаб ўтилган хусусиятлар TMR1 таймерининг микроистеъмол 

қилиш режимидаги (SLEEP) ишлаш имкониятини таъминлаб беради. 

TMR1 таймери ёрдамида олдинги бўлувчидан фойдаланмаган ҳолда 

шакллантириш мумкин бўлган максимал вақт оралиғи 65 536 ҳисоб 

импульси, олдинги бўлувчи билан эса – 524 288ҳисоб импульслари 

даврига тенг. 

Таймер ишини бошқаришмахсус мақсадлар учун мўлжалланган T1CON 

регистри ёрдамида амалга оширилади: TMR1ON бит TMR1таймерини 

ёқади, TMR1CS бит эсаҳисоб импульслари манбаини бериб, T1SYNC 

битсинхронлаштириш узелини ёқади ёки ўчиради, T1OSCEN бит эса 

TMR1 таймерининг ички тактлар генераторини ёқишни бажариб, T1CKPS0 

ваT1CKPS1 битлари кириш олдинги бўлувчининг бўлиниш 

коэффициентини беради.T1CON регистри разрядларининг аниқ 

қийматлари 3.11-расмда берилган. 



 
 

 
3.11-расм. 1 T1CON таймерини бошқариш регистри 

TMR1 таймерининг тузилмавий схемаси 3.12-расмда берилган. У 

махсус мақсадлар учун мўлжалланган икки регистр TMR1H ва TMR1L 

орқали ёзиб олиш ва ахборотни ўқиб олиш мумкин бўлган 16-разрядли 

TMR1 регистр-ҳисоблагичи,  дастурий жиҳатдан фойдаланиб бўлмайдиган 

3-разрядлиолдинги бўлувчидан, икки мультиплексордан, ташқи ҳисоб 

импульсларини синхронлаштириш узелидан, И логик элементидан, Шмит 

триггери ва тактлар импульслари генератори вазифасини бажараётган 

инвертордан иборат. 

Схема уч режимда ишлаши мумкин. 

Ички тактлар генераторининг импульслар ҳисоблагичи.Мазкур 

режимга ўтиш учун «1» ни TMR1ON битга кўтариш, TMR1SC битни эса 

«0» га тушириш талаб этилади. Ички тактлар генераторининг FOSC/4 

частотали импульслари мультиплексор, олдинги бўлувчи, 



 
 

синхронлаштириш узели,иккинчи мультиплексор, И логик элементи 

орқали ўтиб, TMR0 регистр-ҳисоблагичи киришига бориб тушади. Таймер 

шакллантирадиган вақт интервали T нинг давомлилигиқуйидаги формула 

бўйича аниқланади: T = K(216-N), бундаK –олдинги бўлувчининг бўлиниш 

коэффициенти, N эсаTMR1H ва TMR1Lрегистрларига ёзиб олинган 16-

разрядли сон. Ҳисоблагич тўлиб кетганидан сўнг, яъни унинг қиймати 

H'FFFF' дан H'0000' га ўтишида PIR1 регистрида TMR1IF 

байроғикўтарилади ва INTCON регистри GIE ва T0IE битлари ҳамда PIE1 

регистридаги TMR1IE бити «1» га ўрнатиш билан рухсат этилган бўлса, 

тўхталиш келтириб чиқарилади.TMR0 таймеридаги кабивақт оралиғи бир 

марта шакллантирилади, яъни TMR1 таймерини такроран ишлатиб 

юбориш учун TMR1H ва TMR1L регистрларигаҳисобий қийматни 

дастурий юклаш талаб этилади. 

 
3.12-расм. TMR1таймерининг тузилмавий схемаси 

Ташқи тактлар импульслари ҳисоблагичи. Мазкур режимга ўтиш 

учунбиты TMR1ON ва TMR1CS битлар «1» га кўтарилади, T1OSCEN бит 

эса «0» га туширилади. Микроконтроллернинг T1CKI чиқишидаги 

импульслар а через Шмитт триггери вамультиплексор орқали олдинги 

бўлувчининг киришига келиб тушади. Шундан сўнг ҳисоб импульслари 

синхронлаштириш узели киришига бориб тушадилар. 

Микроконтроллернинг ишчи режимида, унинг тактлар генератори 

ёқилганида, ташқи ҳисоб импульсларини микроконтроллер иккинчи ва 

тўртинчи машина такти билан синхронлаштиришмумкин 



 
 

(TMR0таймеридаги каби), бунинг учун T1SYNC бит «0» га тушириб 

юборилади. Микроистеъмол режимига (SLEEPкомандаси) ўтиш олдидан 

синхронлаштириш узелини ўчириб қўйиш зарур бўлиб, бунинг учун 

T1SYNC бит «1» га чиқарилади. Қолган ҳолатларда таймер иши унинг 

биринчи режимдаги ишидан фарқ қилмайди. 

TMR1 таймерининг ичига ўрнатилган тактлар генератори импульслар 

ҳисоблагичи. TMR1 таймери, микроконтроллернинг T1OSO ва T1OSI 

чиқишларига уланадиган,инвертор вақуйи частотали кварц резонатори 

асосида қурилганўз импульслар генераторига эга. Ушбу генератор 

микроконтроллернинг микроистеъмол режимига ўтишида ҳам ўчиб 

қолмайди. Кварц резонатори частотаси 200 кГц дан ошмаслиги керак 

бўлиб, «соатли» кварц резонатори учун стандарт қиймат32 768 Гц ни 

ташкил этади. Ана шу режимга ўтиш учун TMR1ON, TMR1CS ва 

T1OSCEN битлари «1» га чиқарилади (кўтарилади). Қолган қисмида 

таймер иши иккинчи режимдаги каби бўлиб, хусусан таймер шунингдек ўз 

ишини “ухлаш” (суст) режимда ҳам давом эттириши мумкин. 

TMR2 таймери 4-разрядлиолдинги бўлувчиси ва4-разрядличиқиш 

бўлишига эга бўлган 8-разрядли импульслар ҳисоблагичи бўлиб 

ҳисобланади.Мазкур ҳисоблагичнинг хусусияти берилган давомлиликдаги 

вақт интервалларининг чексиз кетма-кетлигини генерациялаш 

имкониятидан иборат (ҳисоблагични дастурий қайта юклаш талаб 

этилмайди).Таймер ёрдамида шакллантириладиган максимал вақт 

оралиғиҳисоб импульсларининг 256 даврига, бўлгичлардан фойдаланган 

ҳолда эса – 65 536 га тенг. 

Таймер иши махсус мақсадлар учун мўлжалланган T2CON регистри 

ёрдамида бошқарилади: TMR2ON бит TMR2таймерни ёқиб,T2CKPS0 ва 

T2CKPS1 битлари киришолдинги бўлувчининг бўлиниш коэффициентини, 

TOUTPS0...TOUTPS3 битлари эса – чиқиш бўлгичининг (делителининг) 

бўлиниш коэффициентини берадилар. T2CON регистри разрядларининг 

аниқ қийматлари 3.13-расмда берилган. 



 
 

 
3.13-расм. 2 T2CON таймерини бошқариш регистри 

TMR2 таймерининг тузилмавий схемаси 3.14-расмда берилган. У 

махсус мақсадлар учун мўлжалланганрегистр кабиёзиб олиш ва ахборотни 

ўқиб олиш мумкин бўлган 8-разрядли TMR2регистр-ҳисоблагичи, 4-

разрядлиолдинги бўлувчи, 4-разрядличиқишбўлгичидан (дастурий 

жиҳатдан фойдаланиб бўлмайди)PR2 давр регистри вақиёсий схемадан 

ташкил топган. 

Схема қуйидагича ишлайди. Таймерни ёқиш олдидан TMR2ON битни 

«1» ўрнатиш билан PR2 давр регистрига таймер ҳар бир циклда ҳисоблаб 

аниқлайдиган импульслар сонини ёзиб олиш талаб қилинади. FOSC/4 

частотали ички тактлар генератори импульслариолдинги бўлувчи орқали 

ўтиб, TMR2 регистр-ҳисоблагичи киришига келиб тушадилар. PR2 давр 

регистри ахбороти вақиёслаш схемаси чиқишидаги TMR2 ҳисоблагичи 

кўрсаткичлари тенглигига эришилганидан сўнг EQ сигнал ишлаб чиқилиб, 

уҳисоблагични қайта H'00' ҳолатга тушириб ташлайди ва ҳисоблагични 

тўлдириш жараёни яна қайтадан бошланади. Чиқиш бўлгичи орқали EQ 

импульслари таймер чиқишига келиб тушадилар ва PIR1 регистрида 

TMR2IF байроғини тиклайдилар. TMR2IF байроғи  INTCON регистри GIE 

ва T0IE битлари ҳамда  бита  PIE1 регистрида  TMR2IE битга «1» ўрнатиш 



 
 

билан рухсат этилган бўлса, узилиш чақириғини келтириб чиқариши 

мумкин. Таймер шакллантирадиган вақт интервали T нинг 

давомлилигиқуйидаги формула бўйича аниқланади: T = K1·P·K2, бунда K1 

– олдинги бўлувчининг бўлиниш коэффициенти, P –PR2 давр регистрига 

ёзиб қўйилган сон, K2 – чиқиш бўлгичининг бўлиниш коэффициенти. 

 
3.14-расм. TMR2таймерининг тузилмавий схемаси 

WDT қўриқчи таймер дастурий издан чиқиш (тўхталиш, осилиб қолиш 

ва ҳ.к.) ҳолатида микроконтроллерни фавқулодда ўчириш учун 

мўлжалланган. Дастур нормал ишлаганида қўриқчи таймер қўриқчи 

таймернингтўлиб кетиш давридан ортиқ бўлмаган интервал билан 

CLRWDT командаси томониданузиб қўйилади. Дастурий издан чиқиш 

ҳолатида қўриқчи таймер тўлиб кетади ва микроконтроллерни узиш 

сигналини ишлаб чиқариб, бунда дастурни бажариш H'000' ни узиш 

вектори адресидан бошланади. 

Қўриқчи таймер такт импульсларини алоҳида ўрнатилганRC 

генераторидан олиб, бу унинг ҳаттомикроистеъмол (SLEEP) режимида ҳам 

ишлашини таъминлайди. Қўриқчи таймерининг ёқилиши «1»га WDTE 

разрядини ўрнатиш билан амалга оширилади. 2007 конфигурация ячейкаси 

ёқилади. Қўриқчи таймернинг тўлиб-тошиб кетиш даври микроконтроллер 

таъминоти кучланиши, вақт тайинлаб берадиган RCзанжири ҳарорати ва 

параметрлари технологик тарқоқлигига боғлиқ бўлиб, 7 дан 33 гача мс ни 



 
 

ташкил этади. Тўлиш даври эса TMR0 таймери билан бирга қўлланадиган 

чиқиш бўлгичини улаш билан 128 мартагача катталаштирилиши 

мумкин(3.9 расмни қар.). Бунда OPTION_REG регистридаги PSA бит «1» 

га чиқарилиб, PS0...PS2 битлари бўлгични қайта ҳисоблаш 

коэффициентини берадилар. 

Ишнинг бажарилиш тартиби 

Мазкур лаборатория ишида микроконтроллер таймерлари ёрдамида 

вақт интервалларини шакллантирадиган дастурни ишлаб чиқиш ва созалб 

олиш талаб этилади. Муайян вазифа ўқитувчи томонидан берилади. 

Мисол тариқасида қуйидаги вазифани кўриб чиқамиз. Бошланғич 

ҳолатда товуш сигнали йўқ. SA6 тугмачасига босганда сигнал частотси 2 

кГц ва янграш даври 1 с бўлган узуқли зуммер жаранглайди. SA6 

тугмачасига қайта босишда товуш ўчади. 

 

Вазифанинг қўйилиши  

Вазифанинг сўзлар билан берилган бошланғич шаклини ўтишлар графи 

кўринишида 3-лабораторияишидаги каби ўтишлар графи (3.15-расм) 

кўринишида тақдим этиш мумкин. 

 
3.15-расм. Дастур бўйича ўтишлар графи  

Расмдан кўриниб турибдики, дастурнинг бор-йўғи икки ҳолати ва улар 

орасида иккита ўтиш мавжуд. Ягона муаммо шундаки, ўтишлар биттаю-

битта тугмачани босиш билан амалга ошади, маълумки, контактларнинг 

туташуви зудлик билан рўй бермай, балки «дребезг» номини олган ҳодиса, 

яъни электр занжирининг кўп марта туташиши ва узилишибилан кечади. 

Шундай қилиб, яна бир бор SA6 тугмачасига босилганидан сўнг дастур 

қайси ҳолатда бўлишини аниқ билиш жуда қийин. Контактлар 

дребезгининг олдини олиш мақсадида қатор усуллар мавжуд бўлиб, 



 
 

улардан энг соддасимуайян вақт давомида контактларнинг очиқ ёки ёпиқ 

ҳолатда эканлигини текширишдан иборат.Аксарият вазиятларда бу вақт 50 

мс дан ошмайди. 

Дастур алгоритмини ишлаб чиқиш 

Асосий дастур алгоритми 3.16-расмда, узилишлар драйвери алгоритми 

эса – 3.17-расмда берилган. 

 
3.16-расм. Асосий дастур алгоритмининг блок-схемаси 



 
 

 
3.17-расм. Узилишларга ишлов берувчи алгоритмнинг блок-схемаси 



 
 

Мазкур дастурда PIC16F873A микроконтроллерининг барча уч 

таймеридан фойдаланилади. TMR0 тугмача контактларини титрашидан 

ҳимоя қилиш учун 50 мс ли сақлаш вақт оралиғини, TMR1 таймери эса 

зуммер ярим даври жаранглашининг ярмига, яъни 0,5 с га тенг вақт 

оралиғини шакллантиради. TMR22 кГц частота даврининг ярмига тенг 

вақт оралиғини шакллантиради. 

Алгоритмнинг биринчи блокида МТР рамзли белгиланишлари бўлган 

матнли файл уланади. 

BZ1А товуш тарқатгич уланган А порти, ахборот чиқаришга, 

тугмачалар контактлари уланган В порти эса – ахборот киритишга 

ростланади. В порти чиқишларига ички тортиб қўядиган резисторлар 

уланади. 

Таймерлардан узилишлар, шунингдек SA6 тугмачаси улаб қўйилган 

INT узилишлар сўровининг ташқи киришидан келган узилишларга рухсат 

этилади. Таймерлартегишли иш режимлари ва вақт оралиқларига созлаб 

қўйилади. 

Иккинчи блокда дастур рухсат берилган манбаларнинг биридан 

узилишлар чақирувини кутади. 

Қолган барча ишлов бериш ишлари узишлар драйверида амалга 

оширилади. 

Узилиш чақириғидан (3-блок) сўнгузилишни келтириб чиқарган 

манбани аниқлаш учун узилишлар байроқларини сўраб чиқиш талаб 

этилади. Бунда бир неча белги бир вақтнинг ўзида киритилиши 

мумкинлигини унутмаслик керак. 4 блокда TMR0 таймеридан узиш 

белгиси текширилади. Агар белги ташланган бўлса,  у ҳолда дастур TMR1 

таймеридан узиш белгисининг сўровига ўтади. Агар TMR0 таймеридан 

узилиш белгиси кўтарилган бўлса, у ҳолда SA6 тугмача ҳолати (5 блок), 

агар у туширилган бўлса, демак бу контактлар дребезги ҳали 

тугалланмаганлигини, ёки контактлар дребезги тугмача қўйиб 

юборилганидан кейин юзага келганлигини англатади. Ушбу ҳолда дастур 



 
 

TMR1таймеридан узилиш байроғи сўровига ўтади. Агар тугмача 

контактларитуташган бўлса, у ҳолда дастур TMR1 таймери ҳолатини 

текширишга ўтади (6 блок). Агар таймер ўчирилган бўлса, у  0,5с вақт 

оралиғига ростланиб, ёқилади (7 блок), 250мкс вақт оралиғига ростланади 

ва товуш сигналини шакллантирадиган TMR2 таймери ёқилади (9 блок). 

Агар TMR1 таймери аввалроқ ёқилган бўлса, ҳар иккала таймер (TMR1 ва 

TMR2) ўчирилади (8 ва 10 блоклар) ва товуш сигнали тўхтайди. 

11 блокда TMR1 таймеридан узилиш байроғи текширилади. Агар 

байроқ туширилган бўлса, унда дастур TMR2 таймеридан узилиш байроғи 

сўровига ўтади. Агар TMR1таймеридан узилиш байроғи кўтарилган бўлса, 

у ҳолда TMR2 таймерининг ҳолати текширилади (12 блок). Товуш 

импульси пайтида TMR2 таймери 250 мкс вақт оралиғига ростланиб, 

ёқилади (13 блок), интервал пайтида эса ўчади (14 блок). 

15 блокда TMR2 таймеридан узилиш байроғи текширилади. Агар 

байроқ туширилган бўлса, унда дастур ташқи манбадан узилишни 

текширишга ўтади (SA6 тугмаси). Агар TMR2 таймеридан узилиш байроғи 

кўтарилган бўлса, у ҳолда А порти иккинчи разрядининг жорий аҳволи (16 

блок) ваунинг тескари ҳолатга ўзгариши (17 ва 18 блоклар) текширилади. 

19 блокда INTF ташқи манбаидан узилиш байроғи текширилади. Агар 

байроқ туширилган бўлса, унда дастур узилишлар драйверидан чиқади (21 

блок), байроқ кўтарилган ҳолида (SA6 тугма контактлари туташуви рўй 

берган), у ҳолда TMR0 таймер 50 мс вақт оралиғига ростланиб, ёқилади(20 

блок). Ундан сўнг дастур узилишларга ишлов берувчидан навбатдаги 

узилиш юзага келмагунича асосий дастурга чиқади.(ИЛОВА 3) 

 

Дастур матнини ҳисоблаш кодларига ўгириш 

Янги лойиҳа ва тўпламлар дастурини тузиш жараёни 1-лаборатория 

ишида батафсил ёзилган. 

 

 



 
 

Тест ўтказиш ва тузатиш 

Дастурни тузатиш босқичида аввалги босқичларда пайдо бўлган барча 

хатоларни аниқлаш ва бартараф этиш зарур. Микроконтроллернинг 

дастурини ёзиш ва дастурни ишга тушириш жараёни 1-лаборатория ишида 

келтирилган. 

Кузатиш  

ОМТ курсини ўрганишда ишлаб чиқиладиган барча дастурлар соф 

таълимий кўринишга эга бўлганлиги сабабли, уларнинг ишлаш 

имкониятини фақат лаборатория ишини ўқитувчига топшириш вақтига 

қадар сақлаб туриш керак бўлади, холос. 

 

Назорат саволлари 

1. Микроконтроллер асосий вақт давомида дастур-намунанинг қайси 

фрагментини бажариш билан банд? 

2. Таймер-ҳисоблагичлардаолдинги бўлувчи нима учун керак? 

3. «Узилиш вектори»нинг ўзи нима? 

4. Қўриқчи таймер ишининг қандай хусусиятлари бор? 
 

IIIбоб бўйича хулосалар 

Магистрлик диссертациясининг ушбу бобида микрокнтроллерлар 

периферия  қурилмалари билан ишлаш, уларга дастур тузиш бўйича 

амалий ва назарий кўникмалар мажмуаси ҳақида баён этилди. Талабалар 

томонидан микропрцессор қурилмалари соҳаси бўйича билимлар 

кўникмасини мустаҳкамлаш учун қуйидаги асосий масалалар кўриб 

чиқилди. PIC микроконтроллерининг ишлаш  ва дастурлаш хотирасини 

ўрганиш. PIC микроконтроллери таймерлари ишини ўрганиш ва 

дастурлаш. PIC микроконтроллерининг  параллел портларини ишлашини 

ва дастурлашни ўрганиш.  

 
  



 
 

Хулоса 

Темир йўлларда поездлар ҳаракатини хавфсиз бошқариш ва назорат 

қилиш бевосита автоматика ва телемеханика қурилмаларининг ишончли ва 

хавфсиз ишлаши билан боғлиқ. Хозирги кунда мамлакатимиз темир 

йўлларида мавжуд реле-контактли тизимлар ўрнига замонавий 

микропроцессорли бошқариш тизимлари жорий қилинмоқда. Шу сабабли 

замонавий автоматика ва телемеханика тизимларига хизмат кўрсатувчи 

малакали миллий кадрларни тайёрлаш Ўзбекистон Темир Йўллари 

олдидаги энг устивор вазифалардан бири хисобланади.  

Диссертациянинг алохида бўлимларида кўтарилган долзарб масалалар 

миллий кадрлар тайёрлаш учун асос бўлиб хизмат қилади. Хусусан 

микропроцессор тизимлари хозирги кунда нафақат темир йўлларда, 

балким ишлаб чиқаришнинг барча соҳаларининг асоси бўлиб хизмат 

қилмоқда. 

Илмий изланиш даврида яратилган микропроцессор қурилмаларини 

ўрганиш бўйича лаборатория мажмуалари талабаларда замонавий 

автоматика тизимлари билан ишлаш, уларга техник хизмат кўрсатиш 

бўйича билимлар кўникмасини беради. 
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ИЛОВАЛАР 

 



 
 

ИЛОВА 1 

3. Ассемблер тилида дастур матнини териш 

 

Дастурнинг бошланғич матнида қуйидагилар келтирилган: 

; дастлабки созламаар 

#include p16f873a.inc 

CONFIG _HS_OSC  

ORG H'000'    

CNT EQU H'A0'      

BCF STATUS,RP1  

BSF STATUS,RP0  

MOVLW H'20'   

MOVWF FSR      

CLRF CNT    

M10: MOVF CNT,W 

MOVWF INDF   

INCF FSR,F   

INCF CNT,F   

MOVF CNT,W  

XORLW H'60'   

BTFSS STATUS,Z  

GOTO M10    

MOVLW H'20'  

MOVWF FSR   

CLRFCNT   

M20: BSFSTATUS,RP1  

BSFSTATUS,RP0   

BTFSCEECON1,WR  

GOTOM20     

BCFSTATUS,RP1  



 
 

BSF STATUS,RP0  

MOVF CNT,W  

BSF STATUS,RP1  

BCF STATUS,RP0  

MOVWF EEADR   

MOVF INDF,W  

MOVWFEEDATA  

BSFSTATUS,RP1  

BSF STATUS,RP0  

BCF EECON1,EEPGD  

BSFEECON1,WREN  

BCFINTCON,GIE   

MOVLW H'55'   

MOVWF EECON2   

MOVLW H'AA'   

MOVWF EECON2   

BSF EECON1,WR  

BCFEECON1,WREN  

BCFSTATUS,RP1  

BSFSTATUS,RP0  

INCFFSR,F       

INCF CNT,F   

MOVF CNT,W  

XORLW H'60'   

BTFSS STATUS,Z  

GOTO M20    

M30: GOTO M30   

END 

 



 
 

            

ИЛОВА 2 

Дастурнинг матнини Ассемблер тилида ёзиш 

Дастурнинг бошланғич матни қуйида келтирилган: 

;дастлабки созламалар 

#include p16f873a.inc 

__CONFIG _HS_OSC ; 

CNT_L: EQU H'20'    

CNT_M: EQU H'21'    

CNT_H: EQU H'22'    

ORG H'000'     

GOTO H'05'       

ORG H'05'     

BCF STATUS,RP1   

BSF STATUS,RP0   

MOVLW B'00001110'   

MOVWF ADCON1    

MOVLW B'00000001'   

MOVWF TRISA    

MOVWF OPTION_REG  

MOVLW B'11111111'   

MOVWF TRISB    

MOVLW B'11000000'   

MOVWF TRISC    

M10: BCF STATUS,RP1  

BCF STATUS,RP0   

CLRF PORTC    

CLRF PORTA    

BTFSS PORTB,5   



 
 

GOTO M30     

BTFSS PORTB,4   

GOTO M20     

GOTO M10     

M20: BSF PORTC,1  

MOVLW D'6'     

MOVWF CNT_H    

MOVLW D'23'    

MOVWF CNT_M    

MOVLW D'22'    

MOVWF CNT_L    

CALL T10     

BCF PORTC,1   

MOVLW D'3'     

MOVWF CNT_H    

MOVLW D'140'    

MOVWF CNT_M    

MOVLW D'11'    

MOVWF CNT_L    

CALL T10     

BTFSS PORTB,5   

GOTO M30     

BTFSS PORTB,2   

GOTO M10     

GOTO M20     

M30: BCF PORTC,1  

BSF PORTA,2  

MOVLW D'1'     

MOVWF CNT_H    

MOVLW D'1'     



 
 

MOVWF CNT_M    

MOVLW D'168'    

MOVWF CNT_L    

CALL T10     

BCF PORTA,2   

MOVLW D'1'     

MOVWF CNT_H    

MOVLW D'1'     

MOVWF CNT_M    

MOVLW D'168'    

MOVWF CNT_L    

CALL T10     

BTFSS PORTB,4   

GOTO M20     

BTFSS PORTB,2   

GOTO M10     

GOTO M30     

T10: DECFSZ CNT_L,F  

GOTO T10     

DECFSZ CNT_M,F   

GOTO T10     

DECFSZ CNT_H,F   

GOTO T10     

RETURN     

END 

 

 

 

 



 
 

 

 

           ИЛОВА 3 

Дастур матнини Ассемблер тилида ёзилиши 

Дастурнинг бошланғич матни қуйида келтирилган: 

;бошланғич созламалар 

#include p16f873a.inc 

__CONFIG _HS_OSC   

ORG H'000'     

GOTO BEGIN    

ORG H'004'     

GOTO INT     

BEGIN: BSF STATUS,RP0 

MOVLW B'00001110'   

MOVWF ADCON1    

MOVLW B'00000001'   

MOVWF TRISA    

MOVWF OPTION_REG  

MOVLW B'11111111'   

MOVWF TRISB    

MOVLW B'00100111'   

MOVWF OPTION_REG  

BCF STATUS,RP0   

MOVLW D'60'    

MOVWF TMR0    

MOVLW B'00110000'   

MOVWF T1CON    

MOVLW H'0B'    

MOVWF TMR1H    



 
 

MOVLW H'DC'    

MOVWF TMR1L    

MOVLW B'00000000'   

MOVWF T2CON    

BSF STATUS,RP0   

MOVLW D'250'    

MOVWF PR2    

MOVLW B'11110000'   

MOVWF INTCON    

BSF PIE1,TMR1IE   

BSF PIE1,TMR2IE   

M10: GOTO M10    

INT: BCF STATUS,RP0  

BTFSS INTCON,T0IF  

GOTO I20     

BCF INTCON,T0IF   

BSF STATUS,RP0   

BSF OPTION_REG,T0CS 

BCF STATUS,RP0   

BTFSC PORTB,0   

GOTO I20     

BTFSS T1CON,TMR1ON 

GOTO I10     

BCF T1CON,TMR1ON  

BCF T2CON,TMR2ON  

GOTO I20     

I10: MOVLW H'0B'    

MOVWF TMR1H    

MOVLW H'DC'    

MOVWF TMR1L    



 
 

BSF T1CON,TMR1ON  

BSF T2CON,TMR2ON  

I20: BTFSS PIR1,TMR1IF 

GOTO I40     

BCF PIR1,TMR1IF   

MOVLW H'0B'    

MOVWF TMR1H    

MOVLW H'DC'   

MOVWF TMR1L    

BTFSS T2CON,TMR2ON  

GOTO I30     

BCF T2CON,TMR2ON  

GOTO I40     

I30: BSF T2CON,TMR2ON 

I40: BTFSS PIR1,TMR2IF 

GOTO I60     

BCF PIR1,TMR2IF   

BTFSS PORTA,2   

GOTO I50     

BCF PORTA,2   

GOTO I60     

I50: BSF PORTA,2   

I60: BTFSS INTCON,INTF 

GOTO I70     

BCF INTCON,INTF   

MOVLW D'60'    

MOVWF TMR0    

BSF STATUS,RP0   

BCF OPTION_REG,T0CS 

I70: RETFIE     



 
 

END 


